INSTALLATION OF USB ADAPTOR
Use these instruction with ESCA 2005 GU Software

The USB upgrade requires Windows 2000 or XP. This upgrade requires USB 2.0 or higher. Most computers with Pentium 4 processors have USB 2.0. You will need to install a USB 2.0 - PCI Card on older computers.

PREPERATION

1. Install USB 2.0 – PCI card if version 2.0 is not on computer. To check for USB 2.0, right mouse click the “My Computer” Icon. This is on the Windows Desk Top for windows 2000 and on the Start Menu on XP Professional. Choose “Properties” at the bottom of the menu. Select the “Hardware Tab”. At the bottom of the list you will see “Universal Serial Bus Controllers”. Click on the + node box. A USB 2.0 Root Hub should be listed. If a yellow question mark is showing for the USB 2.0 Root Hub, the installation failed. **Do not proceed with the upgrade until this is resolved.**

   IF NO USB 2.0 HUB IS PRESENT THEN A USB 2.0 – PCI CARD MUST BE INSTALLED.

2. GPIB Motor Interface. This configuration uses the GU version of the software. Install the National PCI – GPIB interface card in a PCI slot. The ESCA 2005 GU installation disk has the drivers for this interface card. Install the drivers and follow the install instructions. Verify that the card installation passes the National installation test. Attach the GPIB cable to the interface card.

USB ADAPTOR HARDWARE INSTALLATION

1. Modify the Digital Interface card in the 8724/8701 Spectrometer Power supply. The isolated drivers that send signals from the USB Adaptor to the Spectrometer Power Supply need to pick up the floating 5 volts from the Digital Interface Card at the back of the 8724/8701. In the 8724 and the 8701B this modification needs to be made on both of the interface cards. There are two versions of the card in circulation. Figure 1 and 2 show the modifications.

2. Use the pictures included with the manual as a guide for the installation of the USB Adaptor card into the 2503/2401.

3. Connect the Ribbon cable between the 8724/8701 Spectrometer Power Supply and the 2503/2401 Box that contains the USB Adaptor. See Figure 3.
4. Connect the accessories (X-Ray spot size, Flood Gun, Ion Gun) cables to the appropriate connectors. If you have an aperture then the cable connector will need modification. The aperture connector provides relay contact as shown in figure 4. I do not have documentation on the aperture.

5. The Data fan-out panel is no longer used.

SOFTWARE INSTALLATION

Be sure to finish the preparation section before performing the software installation. Start this section with the USB cable disconnected from the computer. Be sure the Windows operating system has the latest service pack installed.

1. The software disk provides all components for a full installation on a new computer. The USB provides a very efficient interface that is well supported on a Pentium 4 computer running Windows XP. The performance is quite impressive. The dead time for power supply setup and data transfer is less than 0.25 ms.

2. Find the ACCESSRT folder on the installation CD and click on the SETUP Icon. This will install the Access Runtime software.

3. Next find the ESCA 2005 G folder. Double click on the SetUp.exe file. Accept the standard installation. If you are asked if you want to keep newer files that exist on your hard drive select YES. After the install reboot the computer.

4. Plug the USB cable into the USB 2.0 card. The computer will report it found new hardware. It will open a wizard for installation. You will be given an opportunity to let Windows look for a driver or you may select from a list of possible drivers. Select the default to let Windows search for a driver. The next page will allow you to select where Windows should look. Click the button for CD drive and browse the ESCA 2005 EU CD for the "USB Driver" folder. Select the i386 subfolder and then select the "spiusbdap.inf" file. Accept this choice and continue with the Wizard. It should install the driver and notify you that all is OK. Reboot only if Windows suggest it.

5. Open the Start menu > Programs > ESCA 2005 and start the ESCA Capture program. You will a notification that the registry entries have been finished and you will need to restart the program. Upon the restart you will be presented with the registration dialog. Email the number in the dialog to barb@sphysics.com and we will e-mail back a matching serial number. Do not close the dialog until you receive the matching number. The dialog number is recalculated each time the application is opened until the registration is complete.
6. If you get a report that the Signature file was not found go to the Settings > Capture Settings and select the Detector Tab. Fix the path to your Sig.txt file.

NOTE ABOUT TRANSFERING CALIBRATION INFORMATION

This note applies if a new computer is replacing an old computer and the old computer is running ESCA VB, ESCA 2000 or ESCA 2005. These older programs do not have a utility built in to record the registry setting for the calibration parameters.

A utility called “RECOVER OLD REGISTRY SETTINGS” is available to upgrade the old software. The registry setting can then be saved to disk or “stick” memory and transferred to the new computer.

Install the “RECOVER OLD REGISTRY SETTINGS” program on old computer.
   a. Copy the XpsSetup program to the ESCA program directory and double click.
   b. The program will update your “Set Up ESCA” utility and open a copy of the utility.
   c. Open the “Configuration” Tab and select the “Save to File” button.
   d. Provide a file name such as OldESCAcal.hml, Select a directory and Select “Save”
   e. The OldESCAcal.hml file can now be transferred to the New Computer.
      We recommend you make a folder in the ESCA 2005 folder. You can later name your calibration files Cal070119.hml, where the number is a date code.
   f. Open the Capture program. Open the Setting Menu in the top toolbar.
      Select “Set Up ESCA”. Select the “Configuration” Tab and select the “Load From File” Button. Find the folder that contains the OldESCAcal.hml file select the file and select “Open”. The calibration has been transferred.

NOTE ABOUT THE USB INTERFACE

If the USB interface connection is disconnected the ESCA capture program will provide a notification. This notification is triggered when the program tries to access the USB device on the Adaptor card. Instructions are provided on how to reestablish a connection. It is strongly advised to always use the Windows Device Manager to check that the SPI ESCA USB Adaptor is listed with out any yellow question marks or warnings.
Figure 1. Old Style Digital Interface Board. (This board has numerous cuts, jumps and extra parts.) Add jumper from 5 Volt bus at capacitor to input connector pins 4 and 5. Also jumper from connector pin 6 to pins 2 and 3. Wire is white.

Figure 2a. New style Digital Interface Board. 5 Volt jumper from pin 1 of RP3 to ID1 top hole only. BE SURE NO JUMPER BETWEEN THE TWO HOLES OF ID1OR 2.
Figure 2b. Digital Interface Card – Component side. Jumper between Pins 4 and 5 of input connector.
Figure 3  Ribbon Cable from USB Adaptor to 8701/8724 Spectrometer Power Supply.

Figure 4. The first flag will come up when "ONE" is selected. The second flag will come up when "BOTH" is selected. The software switches both relays when "Both" is selected.
SOFTWARE UPGRADE INSTRUCTIONS
The USB will not work with a NT operating system. It is recommended that a complete installation of XP be used. The upgrade will work with Win 2000.

This upgrade will not affect the registration, calibration constants, signature files or user defined databases. A new folder named ESCA 2005 will be used for this installation and your older files will remain in ESCA 2000 or folders you have set up.

Some installation have had components changed since the UNINSTALL file was created. An incomplete uninstall will lead to incompatibilities in software modules. PLEASE FOLLOW THE INSTRUCTIONS ABOUT REMOVING MODULES THAT WERE NOT UNINSTALLED. This is a little tedious but the problems from an incomplete uninstall are much worse. Sorry for the inconvenience

Install RegSvr utility. Put the ESCA 2005 EU CD in the drive and find the "misc. goodies" folder. Copy the "RegSvr.reg" file to the root of the C: drive. Double click on the "RegSvr.reg" file. It will ask if you are sure you want to write to the registry. Respond Yes.

1. Uninstall the existing ESCA 2000 program. Open the Windows Control Panel from the Windows Start Menu. Select the Install/Uninstall Software utility. Find the ESCA 2000 program and click the install/uninstall button. Select “Uninstall All”. If it reports it can’t uninstall a module select OK and keep going. Just keep making selection that do the best you can at removing all modules even the shared ones

REMOVING MODULES THAT WERE NOT UNINSTALLED.
First open “Windows Explorer”. Go to C:\Program Files\ESCA 2000. If you see a Viewer folder delete it and the Viewer.ocx it contains. Look for the following files and delete them if they exist.
TestJoystick.exe
SixK.Wiz.exe
Analysis.exe
DosImport.exe
ESCA 2000 E.exe
StartRupE.exe
StartRupA.exe
All files that end in .OCX or .DLL

Go to C:\Winnt\System 32. Go to the bottom of the list. Look for any of the following files. Right mouse click on each dll file that exist.
XprobeController.dll
XprobeMotorControllib.dll
XprobeSerialize.ocx
XprobeSetup.dll
XprobeSetup1.dll
XpsDataLib.dll
In the menu select “Unregister Com Server”. Windows will report if it is successful. After the file is unregistered delete the file.

Open the Start menu > Programs > ESCA 2000. Delete all entries. Remove all ESCA related Desk Top short cuts.

Now proceed with the Software Installation instructions above.
Capture
HIGHLIGHTS OF NEW FEATURES

1. New Capture Desktop - Experiment Mode 4
2. New Capture Desk Top - Recipe Mode 5
3. Export of Raw Data 6
4. ESCA Control Panel – Replacement for A Quick 8
5. Motor Control Panel – GPIB Interface 9
6. Motor Control Panel – Ethernet Interface 10
7. Position Table 11

TOPICAL DESCRIPTION OF SOFTWARE

In the following sections, topics of operation are discussed in alphabetical order

1. Calibration and Setup
   a. Introduction to applet 13
   b. Outline of steps 14
   c. Hardware configuration 14
   d. Software configuration 15
   e. Establishing starting calibration values 17
   f. Run DAC to calibrate BE span 19
   g. Run Detector Width Calibration 20
   h. Run V1 curves 21
   i. Signature correction 22

2. Database Functions
   a. Creating a new database 26
   b. Get recipes from another database 27

3. Depth Profiles
   a. Open the depth profile table generator 29

4. ESCA Control Panel
   a. Unscanned mode 31
   b. Scanned Mode 32
   c. Quick survey 33

5. Experiment Names as part of the database structure. 35
6. Graphics controls
   a. Chart editor
   b. User Preferences
   c. Print Utility
   d. Spectrum color
   e. Clipboard

7. Motion Control
   a. Angle Resolve and tilt stage setup
   b. Enable/Disable Buttons
   c. Home controls
   d. Mode control of the Joystick buttons (6K4)
   e. Panic Button
   f. Position Table Setup
   g. Rotation
   h. System Configuration (GPIB, 6K4, disable axes)
   i. Units, coordinates
   j. Velocity Setup (GPIB with 2100 Indexers)

8. MRS Tables
   a. Construction by selecting and editing Functions
   b. Templates
   c. Run Controls

Software conventions

1. When text boxes are White they will accept data entry.

2. When text boxes are Blue they are read only.

3. Buttons or labels that are Red indicate something is turned off.

4. Buttons that are Green indicate something is turned on.

5. Buttons that are Yellow indicate something is turned on but temporarily not in a useable state.
New Capture Desktop - Experiment Mode

A Quick is no longer available. There is no requirement to create a recipe. When in Experiment Mode, simply edit the MRS table to create a parameter set for the next data acquisition. The MRS table will be stored with the data.

The Experiment Tree shows the past experiments. Selecting an experiment will recall the stored MRS table. You have four options:

1. Run MRS table with a new Project/Experiment name.
2. Modify MRS table and run with new Project/Experiment name.
3. Overwrite recalled Experiment.
4. Save MRS table as a Recipe. To save MRS as a recipe use File menu, Save As – Recipe.

The Clear button provides a quick way to start a new MRS table. Don’t worry about the existing MRS table. If it has been run it is saved. All MRS tables saved with experiments have the Recipe name “None”.

4
New Capture Desk Top - Recipe Mode

1. Save Recipe. Requires Recipe Mode. Saves current state of MRS table to active recipe. Save Icon causes same action.

2. Save As – Recipe creates a new Category/Recipe. May be used from Experiment Mode.

3. In Recipe Mode changes to MRS are NOT saved unless the Save Recipe or Save Icon is used. Recipes should not be changed after they are established. This can cause unexpected results in linked Position Tab.

To create a new recipe just Clear the current MRS table and then compose a new table. Then to turn the MRS table into a Recipe:

1. Go to File menu and select Save AS - Recipe
2. File out the Category name, Recipe name and description.
3. You can browse to an existing Category and then edit the Recipe. This provides a fast way to add Recipes in a sequence.
Export of Raw Data

1. Select an Experiment. If only some regions are to be exported mark them visible.
2. Select Export in the File menu.

3. Choose All regions or Only Visible regions. Select type of export.
Export of Raw Data – Cont.

The VAMAS export is an ASCII file readable by any text editor. The arrangement of information follows the international standard for Surface Science Data. All region of the MRS can be included in one VAMAS file. The VAMAS file can hold a complete depth profile. This is a very flexible and well-defined export file.

To use the Excel export, Excel must be available on the computer running the ESCA application. It does not need to be running. The export will open an Excel notebook, fill header cells with instrument parameters and provide a column of numbers representing the spectrum data. A crude graph is also created for quick review. There will be one page per spectrum. All spectra for a MRS table or just the regions marked visible can be included. A depth profile can be exported.

Fakedata.txt is an internal text file used for demonstration purposes. Any spectra can be converted to a fakedata.txt file and then used by the Demo program to simulate the collection of data. This can be convenient for training and remote investigation of the program operation.

The Export File Dialog is used with the VAMAS export. This is a standard Windows dialog. File storage for the Excel is handled out of the Excel program.
The ESCA control panel is used for direct access to the spectrometer. You may change a setup condition and hit start even if a scan is in progress. The scan will automatically abort and restart. The Time/Step can be changed. If scanned is checked “Capture T” provides an estimate of the total capture time. The top row of controls will change the state of the ESCA when the control is clicked. The eight controls in the frame change state when the Start button or Enter Key is hit.
Motor Control Panel – GPIB Interface

1. Configure Motors:
   a. Set type of motion control interface
   b. Turn on/off individual axes.

2. Velocity Setup:
   a. Set velocity of individual axes.

3. Home Controls
   a. Set XYZ: Set current XYZ position 0,0,0
   b. Set R: Set current R position 0
   c. GOTO XYZ: Return to XYZ = 0,0,0
   d. GOTO R: Return to R = 0 or 360

4. Rotation
   b. Stop Stops continuous rotation.

5. Panic Stops all motion and disables Motors.


7. Units:
   a. XYZ: Set scale system to MM, Inches or number of steps.
   b. Rotation: Set scale system to Deg, number of steps or tilt.
   c. GOTO or Get * IF number is present in any white box then motors will move to position. If all boxes empty then computer will get current position. This is useful after Joystick movement of stage. * denotes that the Enter Key will produce this function if form is active.
Motor Control Panel – Ethernet Interface

The Ethernet interface and 6K4 controller allow for use of a USB Joystick. The Joystick button has three states:

Green – Enabled
Yellow – Motion under computer control
Red – Disabled. This secures the motion system from accidental input while running a position table.

The button labeled “Joystick Buttons” controls the state of the remote buttons located of the joystick. Two buttons can be set to update the home positions or to cause forward or back stepping through the position table. The state is toggled between these two functions by this button. The message box in red with yellow letters describes the current state.

It will be noticed that one additional difference between the GPIB/2100 Indexer system and the Ethernet/6K4 system is the speed of operation. The Ethernet communication provides real time position information during the motion of the stage. The blue read only boxes post the position in real time.

Page 51 for Position Table Setup
Position Table

Steps to set up Position Table:

1. Tool Bar > View > Motion Control Pnl
2. MRS Table function > PT M > Table Name (Default in this case) > Design Button.
3. Table options:
   a. Create a new table, Clear the displayed table, Delete the displayed table or Save and run table.
   b. Create a table of positions:
      i. Learn positions using joystick.
      ii. Move to positions using control panel, then transfer to table.
      iii. Numerical entry directly to table.
   c. Table Row controls
      i. Add row
      ii. Delete row
      iii. Move row up
      iv. Move row down
4. Review of positions.
   a. Select "numbered" buttons at end of Row. Stage will move to position.
   b. Select Step forward/Step Back buttons on Table Form.
   c. Select Step forward/Step Back buttons on USB joystick (6K4 controller).

5. Assign recipes
   a. Select Recipe mode. Click drop down box for each row. Assign Recipe from list.

It is very important to step through all positions before running a table. We have noticed that the positions will not be the same on the first pass after learning. However, as the positions are reviewed buy stepping through them in order, it is easy to refine the stored coordinates by using the joystick learn button. The row cursor automatically follows. This usually stabilizes the learned positions.

As the positions are reviewed, be sure limit conditions are not displayed. During the running of a position table a limit condition will keep the stage form moving to the correct position. You will be notified if this occurs.

To run the position table:

1. "Save and Exit" the position table
2. Enter the Project, Experiment and Experiment description information.
3. Select the Run (from top) button

During the collection of data the MRS table will display the individual MRS tables for each position. The Experiment Name window will display:

Your Experiment Name:POS X where X is the position number.

For more details on Position tables See "Position Table Setup" pg 51
Calibration and Setup – Outline of steps

It is very helpful if the calibration parameter values, from the previous software, are available. If you are upgrading from ESCAVB without a change of operating system these steps are not required. If a new operating system was installed then proceed with calibration.

1. Configure the registry entries for the ESCA system hardware.
2. Configure calibration parameter values that were used in previous software. If these are not available then develop a rough set of starting values.
3. Run DAC to calibrate the span of the BE scale.
4. Run Detector Width to calibrate the detector and set the absolute BE.
5. If the ESCA Instrument has a V1 (lens focus voltage) supply in the Spectrometer Power Supply that is digitally controlled then run V1 calibration curves.
6. Return to the main program and set up Signature correction.

Calibration and Setup – Hardware configuration

Use the main tool bar and select the Settings menu. Select Capture Settings.
**Calibration and Setup** – Hardware configuration - Detector

Select the Detector Tab in the Dialog. If a valid signature file is available then check the Signature Correction ON box. If this is a new installation then see Signature Correction section below.

If the “Signature file could not be loaded” message was displayed during the startup of the program check the Signature File Path. The sig.txt file, that holds a valid signature, must be available. The installation will make a dummy sig.txt file that makes no signature correction. It is loaded in the ESCA 2000 folder. To use this default file make sure the path points to the ESCA 2000 folder. If you set up a custom folder then enter the custom path statement in the Signature file Path window.

The Dither box should be checked if a 2502 fast detector and 2503 buffer memory are used. If a 2401 Position computer is used do not check the Dither box.

Horizontal Linerization is not available in this release.
Calibration and Setup – Hardware configuration – X-Rays

Standard settings for a Monochromator system.

A. Source Type: Al
B. Filter: Monochromator
C. Reference Energy: 1486.6 is provided as the accepted value
D. Please select the type of X-Ray gun controller

Note: “Other” is used for X-Ray guns that are not controlled from this software. The VG 8730 can be controlled using the 8702 L/S.

Non-Monochromator Systems

A. Select source Type from list
B. Select None or Foil.

None will establish a list of satellite peaks with full intensities as specified in the literature. Foil will allow adjustment of the satellite intensities. This is an empirical process. We assume the satellites are attenuated by the window foil. The Filter Transmission Fraction is the Transmission for the satellite peak compared to the Primary
peak. The Transmission Fraction can be specified for the satellite nearest the Primary peak and the satellite farthest from the Primary peak. A linear variation in transmission is computed for the intermediate peaks.

The Filter Transmission Fractions are determined by collecting a spectrum and then using the Satellite subtract function in the Tools menu found at the top of the spectrum display window. Adjust the Filter Transmission Fraction for the Near Peak until the subtraction produces a smooth baseline in the region of the near satellite. Then adjust the Filter Transmission Fraction for the far peak. You may need to iterate the setting a few times. Your final Transmission values will be saved with all spectra at the time of capture. The satellite subtraction can be performed in the Capture program or the Data Analysis program.

Refer to Satellite Subtraction in the Data Analysis section under Manipulating Spectra.
Calibration and Setup – Hardware configuration – Spectrometer

1. Select the type of spectrometer power supply from the drop down list.
2. Select the type of lens from the drop down list.

If the Spectrometer Power Supply entry is changed then you must exit the Capture Application and re-start it so the instrument interface and be re-initialized. You will be reminded of this requirement when the Capture Setting Dialog is closed.

Updating the Registry

If you Cancel the dialog or use the “X” button, none of the changes made during your session with the Capture Setting Dialog will be saved. You must use the Update button to save your changes. The dialog will close after the Updates are complete, so it is convenient to make all desired changes before Updating.
**Calibration and Setup** – Calibration Parameters

To enter calibration parameters into the registry open the Set up ESCA applet.
Calibration and Setup – Calibration Parameters

The calibration parameters are entered into the Configuration Table located on the Configuration Tab.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Value</th>
<th>Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BufferMemoryType</td>
<td>2412</td>
<td>String</td>
<td>Type of buffer memory board. Must be 2412.</td>
</tr>
<tr>
<td>InterruptNumber</td>
<td>5</td>
<td></td>
<td>Integer number used by buffer memory board to force a new acquisition</td>
</tr>
<tr>
<td>GPIO12Base</td>
<td>640</td>
<td></td>
<td>Used to communicate with the buffer memory board.</td>
</tr>
<tr>
<td>GPIO13Base</td>
<td>704</td>
<td>DWORD</td>
<td>Port used to communicate with the analyzer controller</td>
</tr>
<tr>
<td>GPIO14Base</td>
<td>768</td>
<td>DWORD</td>
<td>Port used to set the accessory bits.</td>
</tr>
<tr>
<td>SpotType</td>
<td>1</td>
<td>DWORD</td>
<td>Not used at present</td>
</tr>
<tr>
<td>Ctrl12Null</td>
<td>0</td>
<td>DWORD</td>
<td>Controls logic of strobe handshaking bit.</td>
</tr>
<tr>
<td>Ctrl13Null</td>
<td>16</td>
<td>DWORD</td>
<td>Controls logic of strobe handshaking bit.</td>
</tr>
<tr>
<td>Ctrl14Null</td>
<td>16</td>
<td>DWORD</td>
<td>Controls logic of strobe handshaking bit.</td>
</tr>
<tr>
<td>SupplyType</td>
<td>0</td>
<td>DWORD</td>
<td>Not used at present</td>
</tr>
<tr>
<td>SupplyRange</td>
<td>1</td>
<td>DWORD</td>
<td>Applies to supply type 8724 only: 0=Range-1, 1=Range-2</td>
</tr>
<tr>
<td>MsResSettleTime</td>
<td>12000</td>
<td>DWORD</td>
<td>Setting time in milliseconds following a change of analysis</td>
</tr>
<tr>
<td>DetWidthRes1</td>
<td>3.500000</td>
<td>String</td>
<td>If detector coefficients are missing, this value/128 is used</td>
</tr>
<tr>
<td>DetWidthRes2</td>
<td>7.000000</td>
<td>String</td>
<td>If detector coefficients are missing, this value/128 is used</td>
</tr>
<tr>
<td>DetWidthRes3</td>
<td>13.50000</td>
<td>String</td>
<td>If detector coefficients are missing, this value/128 is used</td>
</tr>
<tr>
<td>DetWidthRes4</td>
<td>20.00000</td>
<td>String</td>
<td>If detector coefficients are missing, this value/128 is used</td>
</tr>
<tr>
<td>DetWidthRes5</td>
<td>1.500000</td>
<td>String</td>
<td>If detector coefficients are missing, this value/128 is used</td>
</tr>
<tr>
<td>PassEvRes1</td>
<td>30.00000</td>
<td>String</td>
<td>Not used at present time</td>
</tr>
<tr>
<td>PassEvRes2</td>
<td>50.00000</td>
<td>String</td>
<td>Not used at present time</td>
</tr>
<tr>
<td>PassEvRes3</td>
<td>100.0000</td>
<td>String</td>
<td>Not used at present time</td>
</tr>
<tr>
<td>PassEvRes4</td>
<td>150.0000</td>
<td>String</td>
<td>Not used at present time</td>
</tr>
<tr>
<td>PassEvRes5</td>
<td>15.00000</td>
<td>String</td>
<td>Not used at present time</td>
</tr>
</tbody>
</table>

After entering changes to the values you must select the Commit button to write the changes to the registry.

Type 5000 for the MSResSettleTime. This will shorten the wait time when the resolution is changed from 12 seconds to 5 seconds.

If you have calibration values from the HP workstation (9800 series) then one adjustment to the calibration values is required. For each Resolution correct the pass energy. Use the Detector With for the same Resolution as the Pass Energy.

New Pass energy = Old Pass energy + (Detector Width)/2

If you are upgrading from the DOS Vectra software or have installed a new operating system then use the pass energy that was previously used.
Calibration and Setup – Calibration Parameters cont.
Make the following entries to the Configuration table if data is available.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DetWidthRes1</td>
<td>2.64117916327077</td>
<td>String</td>
</tr>
<tr>
<td>DetWidthRes2</td>
<td>7.28235832654195</td>
<td>String</td>
</tr>
<tr>
<td>DetWidthRes3</td>
<td>15</td>
<td>String</td>
</tr>
<tr>
<td>DetWidthRes4</td>
<td>21</td>
<td>String</td>
</tr>
<tr>
<td>DetWidthRes5</td>
<td>1.45</td>
<td>String</td>
</tr>
<tr>
<td>PassEvRes1</td>
<td>32.1020161365453</td>
<td>String</td>
</tr>
<tr>
<td>PassEvRes2</td>
<td>59.3277305557</td>
<td>String</td>
</tr>
<tr>
<td>PassEvRes3</td>
<td>113.564644458565</td>
<td>String</td>
</tr>
<tr>
<td>PassEvRes4</td>
<td>166.5961771421</td>
<td>String</td>
</tr>
<tr>
<td>PassEvRes5</td>
<td>12.8</td>
<td>String</td>
</tr>
<tr>
<td>SensitivityExpRes1</td>
<td>0.200000</td>
<td>String</td>
</tr>
<tr>
<td>SensitivityExpRes2</td>
<td>0.700000</td>
<td>String</td>
</tr>
<tr>
<td>SensitivityExpRes3</td>
<td>0.700000</td>
<td>String</td>
</tr>
<tr>
<td>SensitivityExpRes4</td>
<td>0.700000</td>
<td>String</td>
</tr>
<tr>
<td>SensitivityExpRes5</td>
<td>0.700000</td>
<td>String</td>
</tr>
<tr>
<td>V1OffsetRes1</td>
<td>59.867340</td>
<td>String</td>
</tr>
<tr>
<td>V1OffsetRes2</td>
<td>84.01873</td>
<td>String</td>
</tr>
<tr>
<td>V1OffsetRes3</td>
<td>142.721457</td>
<td>String</td>
</tr>
<tr>
<td>V1OffsetRes4</td>
<td>226.855499</td>
<td>String</td>
</tr>
<tr>
<td>V1OffsetRes5</td>
<td>100.000000</td>
<td>String</td>
</tr>
<tr>
<td>V1SlopeRes1</td>
<td>0.423228</td>
<td>String</td>
</tr>
<tr>
<td>V1SlopeRes2</td>
<td>0.442913</td>
<td>String</td>
</tr>
<tr>
<td>V1SlopeRes3</td>
<td>0.492126</td>
<td>String</td>
</tr>
<tr>
<td>V1SlopeRes4</td>
<td>0.545024</td>
<td>String</td>
</tr>
<tr>
<td>DeltaEvSpot1</td>
<td>0.000000</td>
<td>String</td>
</tr>
<tr>
<td>DeltaEvSpot2</td>
<td>0.000000</td>
<td>String</td>
</tr>
<tr>
<td>DeltaEvSpot3</td>
<td>0.000000</td>
<td>String</td>
</tr>
<tr>
<td>DeltaEvSpot4</td>
<td>0.000000</td>
<td>String</td>
</tr>
<tr>
<td>DeltaEvSpot5</td>
<td>0.000000</td>
<td>String</td>
</tr>
<tr>
<td>XyzMotorsOn</td>
<td>0</td>
<td>DWORD</td>
</tr>
<tr>
<td>RMotorOn</td>
<td>0</td>
<td>DWORD</td>
</tr>
<tr>
<td>RCode</td>
<td>1106</td>
<td>DWORD</td>
</tr>
<tr>
<td>XCode</td>
<td>1107</td>
<td>DWORD</td>
</tr>
<tr>
<td>YCode</td>
<td>1108</td>
<td>DWORD</td>
</tr>
<tr>
<td>ZCode</td>
<td>1109</td>
<td>DWORD</td>
</tr>
<tr>
<td>Cal_V0_8701</td>
<td>40</td>
<td>String</td>
</tr>
<tr>
<td>Cal_V0_300_8724</td>
<td>640</td>
<td>String</td>
</tr>
<tr>
<td>Cal_V0_1500_8724</td>
<td>163.9</td>
<td>String</td>
</tr>
<tr>
<td>Cal_V0_3000_8724</td>
<td>80.000000</td>
<td>String</td>
</tr>
<tr>
<td>Cal_V1_8701</td>
<td>40.000000</td>
<td>String</td>
</tr>
<tr>
<td>Cal_V1_8701</td>
<td>40.000000</td>
<td>String</td>
</tr>
</tbody>
</table>

- Use Existing Detector Widths if available.
- Enter Pass Energies as discussed above.
- Enter Sensitivity Exps only if special values have been established.
- V1 offsets and Slopes for 8701B or 8724 only. Note values for V1 curve setup.
- DeltaEvSpot depends on crystal adjustment. Do after all other adjustments.
- Motor parameters, all 6, not used.
- DAC for 8701
- DAC for 8724
Calibration and Set up – Establishing starting calibration values

If the above calibration values are not available then follow these steps:

1. Set DetWidthRes4 to 19 eV and the PassEVRes4 to 166 eV. Make these entries in the configuration table and use the Commit button to register these values. Leave all other values as shipped.
2. Set up a gold sample and be sure all supplies are on. Set the X Probe Spectrometer Setup control panel as shown below and Start Accumulation.

If you are using a 2401 position computer then the dithered box should be unchecked. For a 2503 Memory Interface check the dithered box. This applies at all times.

![X Probe Spectrometer Setup](image)

This will generate a spectrum of the Au 4f. With the cursor set at the center of the 7/2 peak, read the BE at the upper right corner of the spectrum display.
**Calibration and Set up** – Establishing starting calibration values cont.

3. Calculate the following:
   New PassEVRes4 = 166 + (measured peak position – 84).
   Enter the new pass energy into the configuration table and select Commit.

4. Set up following unscanned spectrum
   a. Remove the check mark from the box titled “Scanned”.
   b. Center BE = 85.8.
   c. Window Width = It will use the Detector Width. No input needed.
   d. Number of data points = It will use 128. No input needed.
   e. Number of Scans/Reads = 200
   f. Start Accumulation
   After spectrum is accumulated, use cursor to measure separation between the Au 4f 5/2 and Au 4f 7/2 peaks.

5. Calculate the following:
   New DetWidthRes4 = 19 * (3.68 / measured peak separation).
   Enter new Detector Width into configuration table and select Commit.

6. Make following entries:
   a. DetWidthRes2 = (DetWidthRes4) / 3
   b. DetWidthRes3 = (DetWidthRes2) * 2
   c. PassEVRes2 = (PassEVRes4) / 3
   d. PassEVRes3 = (PassEVRes2) * 2

These starting values will now be used in the automatic program to refine the
 calibration.
Calibration and Set up - Run DAC to calibrate BE span.

The DAC calibration is very simple. Align the copper sample under the microscope. Clean the sample with an Ion Etch. Then select start. The spectra will be displayed as they are collected. The display window will provide information as the calibration progresses.

The DAC calibration may fail to find the Cu 3s1/2 peak in the preset window. Small errors in the DAC constant will cause large errors in the Cu 3s1/2 peak location. You will need to provide an improved initial estimate of the DAC value. Run a 100 Ev wide scan centered at 120 Ev and a 50 Ev scan centered at 930 Ev. Find the centers of the Cu 3s ½ and Cu 2p 3/2 peaks using the cursor. Compute:

\[ \frac{(\text{Cu } 2p3/2 - \text{Cu } 3s1/2 \text{ energy separation} / 810) \times \text{current DAC}} \]

Enter this value of the DAC into the configuration table. Follow steps 1 through 3 above to re-establish the Au 4f7/2 line position to 84 Ev. Re-run the DAC calibration.
Calibration and Set up – DAC calibration – cont.
The DAC calibration can leave the absolute binding energy far out of adjustment. It is
only attempting to set the separation between the copper peaks to the correct value.
Return to the acquisition tab and collect a scanned spectrum at the Au 4f peaks. Use the
following setup:

CBE  85    Res  2
WW  30    Scans 2
Nbr Pt 300  Scanned box checked
X-Rays on – 600 spot
Calibration and Set up - Detector Width Calibration

Use the cursor to find the center BE for the Au 4f 7/2 peak. Find the value of PassEVRes2 in the configuration table. Calculate:

New PassEVRes2 = current PassEVRes2 + (measured peak position - 84).

Enter the new value of the Pass Energy into the Configuration Table. Make the same calculation for Res 3 and Res 4 but use the Res2 value (measured peak position - 84). Enter these two values into the configuration table. Select Commit to record all three updated values to the registry.

Select the Detector Width Tab. Set the run conditions for Res2, Res3 and Re4 as shown below. Select start. Watch the calibration proceed. If the calibration fails to find two peaks it is usually because the peaks are not well enough centered in the window. Make small changes to the pass energy as described in the paragraph above to center the peaks and try again. This calibration sets the absolute BE for all pass energies.

Note: Increasing the pass energy moves the peaks to lower BE.
Calibration and Set up - V1 curves

This calibration is only needed if the V1 supply is digitally controlled. The V1 curves settings will have no effect on a model 8701 Spectrometer supply unless the supply has a digital V1 upgrade. The optimum voltage setting information may be useful for manual adjustment of the supply.

The V1 curve generator.

The object of running V1 curves is to obtain a set of parameters that optimize the lens throughput for all binding energies. The voltage (V1), that is used to focus the lens, is continuously increased over a range of voltages. As the V1 voltage is changed the number of electron that reach the detector is changed. The goal is to set a start and end for the V1 voltage ramp that produces a maximum detector signal away from either end.
Calibration and Set up - V1 curves – cont.

Each Resolution requires two V1 curves. All curves are created using gold as the sample. The spot size setting does not affect the final Slope and Intercept values. It is best to run with larger spots to improve the signal to noise.

The Check boxes, under the include column, control which curves will be run. The button labeled “Run Test” will start the data collection. After all pairs, that have been checked, are run use the calculate button to calculate the Slope and Offset parameters. These parameters are used in the software to compute the V1 voltage as a function of V0 (retardation) voltage that will keep the lens focus optimized for all binding energies. Review the computed values. The slopes and intercepts should increase smoothly and the resolution number is increased.

Finally select the update registry button to make the new values take effect.
Calibration and Set up – Signature correction

Return to the main Capture program

Select the Capture Settings dialog.

If the ESCA uses a Model 2401 Position computer then the Dither box should not be checked. Check the Dither box if a Model 2503 Memory Interface is used.

Remove the checks from the Signature Correction box and horizontal linearization box.

Enter the Signature File Path as shown above. This will stop the “Signature file not found.” message that is shown when the program is started.

Select update and close the dialog box.

If you have a history of signatures in the C:\Program files\ESCAVB folder, the files can be moved to the C:\Program files\ESCA 2000 folder. These files will have the following endings: sig.txt.1, sig.txt.2, sig.txt.3 etc. Copy all files in this series.
**Calibration and Set up** – Signature correction cont.

Place an Unscanned Function in the MRS table. Set the CBE to 510eV. Input the time as 10:00 to set it to 10 minutes. Set the spot to 800 microns and the resolution to Res4. Use Default and Temp for the Project and Experiment. The collected data does not need to be saved. The computed signature file is saved.

Select Run.

After the data has been collected just leave it displayed. Then select the Setting > Create a new signature file menu.

Select the capture button. The signature will be computed from the data in the spectrum display window of the main program. The signature will be displayed in the signature window.
Calibration and Set up – Signature correction – cont.

Select save to save the sig.txt file and back up the last sig.txt as sig.txt1. All other sig files will be rolled to the next higher number.

Close Signature conversion dialog.

Re-Open the Capture Preferences dialog. Settings > Capture Preferences in main toolbar. Enter a check in the Signature Correction check box.

Set up and calibration is now complete.
Database Functions

It is highly recommended that each user create a personal Data Base!
Click on File > New > New Data Base /Protocol.
Database Functions – Creating a new database

Enter the new database name then select Save.

The categories Depth Profile, Performance Test, Position Table Blank, and Sample Project will be automatically loaded with each new Database.
Database Functions – Get recipes from another database

Recipes can be transferred from one Data Base to another. Go to File > Open > and select the Data Base into which Recipes are to be transferred.

Now go to File > Get Categories/Recipes

Highlight the Data Base that contains the Categories/Recipes to be transferred and click on Open.
Database Functions – Get Recipes from another database – cont.

!!DO NOT TRANSFER OR ALTER THE TEMPLATE DATABASES, ESCA Template.mdb or Programdb.mdb!!

In order to transfer a Category and/or the Recipes highlight the Category and hit the space bar (note that after highlighting a Category or Recipe, hitting the space bar toggles the (-), (+) signs in front of the titles).
Highlight and hit the space bar once for each Category and Recipe that is to be transferred, then click on the Copy button.
If a Category is showing a (+) and all Recipes below the category show (-) then all Recipes in the Category will be copied. This saves the effort of checking all Recipes.

If a Recipe shows(+) but the Parent Category shows (-) the Recipe may not be copied. If the target database (the one you are coping to) has a matching Category then the marked Recipes will be copied.
**Depth Profiles** – Open the depth profile table generator.

1. Select the Depth Profile function from the function list.
2. We suggest that the first Template be a default Template. Use this as a temporary table. It is rare you will reuse a Depth Profile. Continue to step 4 if you are going to write over the default template.
3. If a reusable template is desired then select New. Edit the Template Name. Go onto next step to define the spectrum regions.
4. Use the Add and Delete buttons to create a table of Region Definitions
   a. Region name is typically the element symbol and transition label. When this convention is used, the data reduction will automatically identify the transition and look up the Scofield cross-section.
   b. CBE – Center binding energy
   c. Scanned – checked WW (window width) must be entered with a non 0 value. Scans is number of scans. If a time is entered as hh:mm:ss, then a number of scans will be calculated, but not shown, that equals or exceeds the time. A default eV/step will be offered.
**Depth Profiles – Cont.**

d. Scanned – not checked. WW defaults to detector width. Scans/Time is collection time and can be entered as seconds or hh:mm:ss and finally eV/step is not required.
e. You need to enter a Resolution number in all cases.
f. Hh:mm:ss can be entered as h:mm:ss, mm:ss or m:ss.

5. Set up the Spot Size, Etch Time in seconds or hh:mm:ss, Flood gun state and Number of Etch cycles.
6. The Rotation can be “On” or “Off”. If rotation is “On” then the sample holder will rotate an integer number of rotations during each etch cycle.
7. Select Paste to Save the Table and Close the Depth Profile Dialog.
8. Use the ESCA Control Panel to set up and test the sample alignment, and ion gun operation.
9. When ready select any of the Run Buttons.
10. The Spectrum Viewer will display the Depth Profile during the etch cycle.
ESCA Control Panel

Previous versions of the software used A Quick as a simplified control panel. This update replaces A Quick with the ESCA Control Panel.

The first row of the panel presents check boxes allowing for the activation of the Flood Gun (charge neutralization), Ion Gun, X-ray Gun and, if applicable, Aperture. Changes in these parameters take effect when the boxes are clicked.

The second row and third row are grouped together in a frame. The fields represented in the frame directly control the spectrometer. The Panel is shown with the scan variable not checked. This is the UNSCANNED mode. The active variables are (CBE), Spot size, spectrometer Resolution, and Capture T (time in seconds). Changes in these parameters take effect when the start button is clicked.

ESCA Control Panel – Unscanned mode
ESCA Control Panel - Scanned Mode

Placing a check in the Scans box provides access to Scans number, Window width, eV/step, and Time/step.

The scanned mode is especially useful for establishing the center binding energies of those elements of interest for High Resolution Spectroscopy and also for establishing optimum flood gun parameters.

Note that, while in the scanned mode, the Scan Time field is shaded blue. This indicates that the Scan Time field is a Read-Only field as it is a variable dependent on the other scan parameters.
ESCA Control Panel - Quick survey.

Place a check in the Scans box, type 500 or 550 into the CBE box and 1000 or 1100 respectively in the Window box.
Set Time/step to 50 and click on START.
Note: The overhead time per step is 25 milliseconds. This is not included in the Scan time calculation.

See Big Display at bottom of Panel.

Scans or Time Remaining

Current Count Rate

Very large display of Count Rate.

This display can be expanded and moved. Additional status parameters are then displayed. Available during normal capture.
Calibrating the Microscope for Correct Sample Registration

Place a phosphor sample on a flat stage and transfer it to the UHV chamber. Use the joystick to manipulate it to the vicinity of the registration point. Turn on the Flood Gun, and X-rays. Set the CBE for O(1s) at ~532 eV.

Choose the largest Spot size, Resolution 4, and a large number for Capture T (3000 seconds?). While monitoring the counts adjust the Z-axis of the stage for maximum counts. Also, insure that the “dot pattern” on the CRT is centered (side-to-side).

**NOW, UNTIL THE MICROSCOPE HAS BEEN CALIBRATED, DO NOT USE THE JOY STICK OR DO ANY OTHER MANIPULATIONS TO THE STAGE.**

Turn off the flood gun (the flood gun emission may make the area irradiated by the X-rays difficult to see).

Use the 50X magnification and the eyepiece cross hairs, adjust the Z-axis of the microscope so that the irradiated area of the phosphor is in focus. Now use the microscope's X and Y-axes controls to move the eyepiece crosshairs to the center of the in-focus irradiated area on the phosphor.

If a small Spot size is to be used change the Spot size settings to the appropriate size and recheck the crosshair alignment using the microscope X and Y-axes adjustments.

The microscope is now calibrated.

Now use only the joystick controls to bring samples into focus and areas of interest under the eyepiece crosshairs.
Experiment Names as part of the database structure

The Project and Experiment Names are displayed in a number of places in the program. The two names together form a unique identity for a MRS, Depth profile or one position in a position table. Examples of the tree structures that help to find your data are shown below.

Data Analysis keeps Reduced data with Raw Data for ease of recovery. Raw data is never presented for manipulation. Only a copy is presented in the Spectrum Viewer.
Graphics controls – Chart editor

The chart editor provides control over all aspects of the Graphic presentation of the spectra. In the following sequence of screens we will show some of the typical controls.

The X and Y axis presentation is controlled on the Axis > Scales page. The “Axis” column in the left frame controls the focus of the “Axis” sub pages.

Removing grid lines for X axis. The axis control was changed to Bottom to remove the vertical grid lines in the next screen.
Graphics controls – Chart Editor – cont.

- Bottom Axis selected
- Titles added
- Set Panel Color to White
Graphic Controls – User Preferences

The above sequence shows a few of the capabilities of the Graphic Editor. Many Fonts, font sizes and colors are available. Legends can be created for Graphics with overlays. The panel background can have be a blend of two colors. An depth profiles can be displayed in 3D.
Graphic Control – Print Utility

The General Page of the Graphic Editor provides access to a Print Utility and Graphic Export.
Graphic Control – Print Utility – Cont

The Print Preview can be obtained from the Printer Icon or from inside the Chart Editor. The Chart Editor provides more flexibility. The Printer Icon provides convenience.

Example of printout form Graphics Editor
Graphic Control – Spectrum color

The color wheel icon provides access to the “Change Color and Line Style” dialog.

Graphic Control – Clipboard

The spectrum displayed in the Graphics Viewer can be placed on the Windows Clipboard by clicking on the Clipboard Icon. The image is available for pasting into any Windows program.
**Motion Control** – Angle Resolve and tilt stage setup

1. Load Motion Control Pnl
2. Load Position Table
3. Open Angle Setup

The tilt stage allows for computer controlled variable takeoff angle (TOA) analysis. With the Motion Control Panel open select the PT M function and open the Position Table dialog. This will enable the “Angle Setup” button on the Motion Control Panel. Click the “Angle Setup” button on the Motion Control panel to display the **Tilt Setup** dialog.
Motion Control – Angle Resolve and tilt stage setup – cont.

The relationships described in the Tilt Setup are pictured below.

**Takeoff Angle**

- Lens axis
- Sample normal
- TOA – Surface to Lens Axis - as shown in example.
- Sample surface

**Tilt Stage**

*Shown with bearing support on right.*

- Slot in machined aperture plate
- Bearing support
- Grid line marking tilt (X) axis
**Motion Control** – Angle Resolve and tilt stage setup – cont.

The tilt stage allows for variable TOA analysis and by rotating the stage about its X-axis. The TOA can be varied from 0 to 90 degrees. Mount the sample by placing it between the solid bottom platen and the machined aperture plate.

In order for the software to work properly the following conditions must be met;
The microscope must be calibrated (refer to the section Adjusting the Microscope for Correct Sample Registration on page #17).

Place the sample/stage in the preparation chamber so that the bearing support is located on either the left or right side of the stage.

**Lower the Z-axis to the minimum position before transferring the tilt stage to the UHV chamber.** This is a precautionary step to avoid collisions of the tilt stage with the hardware that protrude into the analytical chamber (i.e. flood gun, lens, ion gun).

Raise and manipulate the stage and superimpose the microscope eyepiece crosshairs on the grid line of the stage. This correctly aligns the tilt stage with the X-ray beam and the lens and the R controller will now tilt the stage.

In this example a TOA of 35° (sample surface horizontal or flat) will be initially defined as home (0, 0, 0, 0). An approximate setting of the horizontal is sufficient for this initial setting.

- **a** Using the unscanned data acquisition mode and a strong elemental line adjust the Z-axis for maximum counts and click on the SET XYZ Home(see next page).
- **b** Now use the Y-axis to move away from the tilt axis (do not move Z). If the counts and signal (dot pattern on the detector) remains constant, then the stage is positioned correctly at TAO of 35° (or 55° if using the lens axis to sample normal as the definition of TOA). If not use R (low speed) and adjust the tilt for maximum counts and click on SET R. This accurately sets the horizontal plane.
- **c** Use GOTO home XYZ to return to the tilt axis. Check and refine the alignment of the grid line on the top machined plate so that it overlaps the microscope cross hair.
Motion Control – Angle Resolve and tilt stage setup – cont.

Aligning Sample for Angle Resolve Analysis

- Slot in machined aperture plate
- Grid line marking tilt (X) axis
- Use Z-axis controller to align center of sample. Click SET XYZ...
- Use the Y-axis and/or R to align an area away from center. Click SET R.

Note angles entered in the R column in the position table on page 42. Enter the set of angles you plan to use in the experiment. Use the add line, delete line etc to organize the table as you choose.

The steps completed to this point are:

1. Select the tile configuration in the Tilt Setup dialog. Close dialog
2. Align the Home condition for the tilt stage as outlined above.
3. With the Motion Control Panel Measurement System set to degrees enter the tilt angles for your experiment.

Now Select the Tilt Measurement System (see pg 42) in the Motion Control Panel. Your input numbers will be converted to Raw motor steps. This conversion will account for the tilt stage gear ratio and the Tilt Setup configuration. The final table is displayed below.
**Motion Control** – Angle Resolve and tilt stage setup – cont.

The Recipes are assigned by selecting the Recipe Display Mode and selecting the Recipes from the dropdown dialog.
Motion Control – Enable/Disable Buttons

Review the last three screens that show the Motion Control Panel. Notice the Motors and Joystick buttons take on the colors Red, Yellow and Green depending on the state of the Motion control system. Clicking either button will toggle the state of the Motors or the Joystick between enabled and disabled (Green or Red).

1. Disabling the Motors turn the power to the motors off.
2. Disabling the Joystick block Joystick control of the motors.

The yellow state is displayed during computer-controlled movement. Notice that a number of control panel buttons are disabled during computer-controlled motion.

NOTE: If the motion system stops working it is often sufficient to Disable the Motors and then re-enable them to restore normal operation. Your Home position will not be lost.

Motion Control – Home controls

The GOTO R button causes the rotation position to return to 0 deg or 360 deg.
Motion Control – Mode control of the Joystick buttons (6K4).

Clicking the “Joystick buttons” button toggles the function of the two front buttons on the Joystick. When the Joystick home is enabled, then the left front button set the current XYZ position as home. Likewise, the right front button will set the current rotation position as home. This is very convenient for initially setting a home position while observing the sample with the microscope.

Later, when reviewing the learned sample positions, the mode can be switched. When the home function is disabled in the Motion Control Panel then the Joystick Step Next/Step Back Function is enabled in the Position Table.
JOYSTICK CONTROL BOX – USB model

The joystick controls motion along the X (left/right), Y (forward/back) and “Z axes (press center button while moving the Joystick forward-back). Rotation is obtained by twisting the outer ring clockwise/counter clockwise.

The Get function “Gets “ the current coordinates and fills or updates in the position cell in the position table.
**Motion Control – Panic Button**

The PANIC button is used to immediately stop all motion!

![Motion Control Interface](image)

All motion is stopped and power is removed from the motors. The current home location is not lost.

To restore normal operation select the Motor button and then the Joystick button. After both buttons turn green, the Motion system will be ready for operation.
Motion Control - Position Table Setup

Setting up the Position Table disables Recipes so, when possible, compose Recipes beforehand.

Use the Function pull down menu and select PT M. Then click the design button ("The Pencil") Icon. This activates the Position Table – Multi Recipe Panel. If the Motion Control Panel is not open it will be opened along with the Position Table.

Set Home

Go to the microscope and set the cross hair on the axis of rotation. Go to the SET row of the MOTION Controls Panel and click on XYZ.

Move toward the edge of the holder, preferably the first sample. SET this position as Home for R. An initial reference co-ordinate system is now set that can be reproduced if there is a glitch.
Motion Control - Position Table Setup cont.

Learning Positions

There are two modes of adding rows to the position table. They are controlled by the radio buttons in the Get Current Positions frame.

1. Select the Update mode. Each time the Add Line button, on the position table form is clicked, a blank row will be added to the table. When the Get Position button is clicked the values for each axis will be updated.

2. Select the Auto Add mode. Rows are added and filled in each time the Get Position button is selected.

The Update mode is convenient for updating or refining the coordinates for an existing table. The Auto Add mode is best when building a table from scratch.

NOTE: The Joystick Get Position button works the same as the button on the form. With Auto Add selected, you can learn all your positions without going back to the computer.

Choose one of the above modes of operation. Put the cursor on the X axis cell of the first row. Row (1). The X axis cell is arbitrary but a good practice. With the stage aligned on position, (Pos 1) click the Get Position button on the Joystick or on the Position table form. The Special Function button is the Get Position button for the old Joystick. If you chose the Update mode the coordinate cells of row (1) will be filled. If you chose the Auto Add mode then you will have a new row at the bottom of the table with the values for the current position.

In the update mode, you will continue to put the cursor on the X column of the row that matches your sample. You will move to a new position and select the Get Position button.

In the Auto Add mode you will continue moving to new positions and selecting the Get Position button. When you are finished, delete any rows left over from previous tables. You will then be left with a table properly numbered.

The screen on the next page shows the controls discussed.
Motion Control - Position Table Setup cont.

NOTE: With the GPIB/2100 Indexer system the Joystick operation is not connected to the computer. Continuous polling of the Indexers to see if there has been Joystick activity leads to less reliable operation. The “Goto or Get” button on the Motion Control Panel is used to request current stage position. This provides the required update. The Motion Control Panel button ONLY updates the Motion Control display. The Get Position Button on the Position Table and the Joystick update both the Motion Control Panel and the Position Table.
**Motion Control** - Position Table Setup cont.

After the desired positions have been entered into the **Position Table** click on the **Recipe** button. This expands the **Position Table – Multi Recipe Panel** so that Recipes may be assigned for each position.

Save the table and Run the analysis.

If, after acquiring the data set, more data is needed, create the appropriate Recipes and insert them into the previous position table. Then Save again.

Previously stored position tables may be reused and edited to accommodate different sets of samples.

**Motion Control** - Rotation

Starts continues rotation

Stops continues rotation
Motion Control – System configuration.

1. No Motors then use “None”
2. National GPIB card us 2100 Indexers with HPIB.

On new installations, check all installed axes.
If a fault message suggests you should uninstall a motor, remove the check for the reported axis.

This configuration dialog will be displayed when the software is first installed. Your responses will be stored in the registry.
**Motion Control** – Units, coordinates.

XYZ Scale units are:

1. mm = millimeters
2. inch = inches
3. raw = number of motor steps (250,000 / inch)

R Scale units are:

1. deg = degrees
2. raw = number of motor steps (36,000 / turn – 6K4 or 25,000 / turn GPIB)
3. tilt = converts TOA (Take Off Angle) to raw. See Motion Control – Angle Resolved.

Enter position coordinates and then click Goto (or keyboard Enter) for manual control. If no position coordinates are entered (i.e. White boxes are empty) then the current motor positions will be recovered from 2100 Indexers. This is not required with 6K4.
**Motion Control** – Velocity Setup (GPIB with 2100 Indexers only)

The **Velocity Setup** only controls the velocities for computer, not joystick control.

![Velocity Setup Panel](image)

The velocity settings are in mm/sec or deg/sec. These settings only control the velocities for computer control. The joystick velocities are set manually in the 2100 indexers.

<table>
<thead>
<tr>
<th>Axis</th>
<th>Adjustment range</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Axis</td>
<td>0.5</td>
</tr>
<tr>
<td>Y Axis</td>
<td>0.5</td>
</tr>
<tr>
<td>Z Axis</td>
<td>0.5</td>
</tr>
<tr>
<td>R Axis</td>
<td>0.5</td>
</tr>
</tbody>
</table>

Command1
MRS Tables

A capture screen, with a new database loaded, will show no MRS table. Select a Recipe to load the MRS table constructor functions.

In this case the Sample Project > Default Recipe was selected. The MRS for this Recipe is a simple survey. We can start from this MRS and modify it to create the parameter table for the Spectrum capture desired. First, a review of the possibilities.
MRS Tables - Construction by selecting and editing Functions.

Adding a new function.

Drop down the Function menu

Select a Function
MRS Tables – Construction buy editing Functions cont.

FUNCTION TABLE CONTROLS

<table>
<thead>
<tr>
<th>Clear</th>
<th>Set next row up the active function</th>
<th>Set next row down the active function</th>
<th>Add new function</th>
<th>Delete current function</th>
<th>Move current function up one row</th>
<th>Move current function down one row</th>
</tr>
</thead>
</table>

The controls for the manipulation of the functions in the table are described above. The **underlined A** and **X** can be executed from the keyboard by using Alt-A or Alt-X.

A **Function** (in this case a **Survey**) creates a list of default data acquisition parameters. The default values are often ok but it is quick to customize the values. For example, the number of **Scans** is often increased or the BE conditions are changed.

**NOTE:** Time, stated as hh:mm:ss, can be entered instead of number of scans. The program will compute a number of scans that most closely matches the requested time. A calculation of zero scans will be run as one scan.

The default parameter **eV/step** is set optimum for the selected **resolution (Res#)**. This applies to high resolution (**ResHi**) and high Sensitivity (**HiSen**) scans.
MRS Tables - Construction by editing Functions cont.

NOTE: TAB or the mouse must be used to step out of the Function column. In the Function column the arrow keys move up and down the Function list and not from Function to parameter columns or Function to Function. The arrow keys move up and down or side to side in the parameter columns. SHIFT TAB will tab right to left. It is fast to fill in a table and then “arrow” down the scan column and set the number of scans at one time.

High Resolution scans and High Sensitivity scans may be added to the table as required by the analysis. For these two cases the binding energy is changed from the default values. This is quickly accomplished by “Arrowing” down the BE column.

<table>
<thead>
<tr>
<th></th>
<th>Function</th>
<th>LBE</th>
<th>Window Width</th>
<th>Spot Size</th>
<th>Scans/Time</th>
<th>Rest#</th>
<th>EV/Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Survey</td>
<td></td>
<td>0</td>
<td>1000</td>
<td>800</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>G Survey 1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Function</td>
<td>CBE</td>
<td>Window Width</td>
<td>Spot Size</td>
<td>Scans/Time</td>
<td>Rest#</td>
<td>EV/Step</td>
</tr>
<tr>
<td></td>
<td>ResHi</td>
<td></td>
<td>284</td>
<td>20</td>
<td>300</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>G HR R2</td>
<td></td>
<td>C 1s</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Function</td>
<td>CBE</td>
<td>Window Width</td>
<td>Spot Size</td>
<td>Scans/Time</td>
<td>Rest#</td>
<td>EV/Step</td>
</tr>
<tr>
<td></td>
<td>ResHi</td>
<td></td>
<td>830</td>
<td>20</td>
<td>300</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>G HR R2</td>
<td></td>
<td>O 1s</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Function</td>
<td>CBE</td>
<td>Window Width</td>
<td>Spot Size</td>
<td>Scans/Time</td>
<td>Rest#</td>
<td>EV/Step</td>
</tr>
<tr>
<td></td>
<td>ResHi</td>
<td></td>
<td>100</td>
<td>20</td>
<td>300</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>G HR R2</td>
<td></td>
<td>Si 2p</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Function</td>
<td>CBE</td>
<td>Window Width</td>
<td>Spot Size</td>
<td>Scans/Time</td>
<td>Rest#</td>
<td>EV/Step</td>
</tr>
<tr>
<td></td>
<td>ResHi</td>
<td></td>
<td>348</td>
<td>20</td>
<td>300</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>G HR R2</td>
<td></td>
<td>Ca 2p</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The above Multi Region Scan (MRS) has a survey and four high resolutions Region. Each region has been named for ease of identification. The region name will default to Region 1, Region2 etc if the names are not entered.
MRS Tables – Templates

The table above displays three templates for the high sensitivity function. After selecting a function you can drop-down the list of named templates that hold a set of default values. For frequently used parameter sets you may want to define your own set of default templates.

To create a new template:
1. Select the New Icon.
2. Enter a new Template Name.
3. Enter the parameter values for your template in the appropriate boxes.
4. The check box will lock the value so it can’t be changed from the MRS table.
5. Select the Paste Icon to save the template and post the name to the Function list.
Befor running the MRS table a Project Name and Experiment Name must be provided. These two names taken together create a unique identity for the MRS in the database. The Experiment Description is for additional information that make clear the Experiment. The discription is not used for finding the data. It is supplied after the data is recovered.

Most of the time there will be a Project Name and Experiment Name in the input boxes. These names will be left from the previous state of the Capture Program. It is most likely you will not change the Project Name. This assumes that you will do many Experiments for one Project. The typical operation will be to write over or modify the Experiment Name. You may add letters or numbers to show a sequence in the experiments.

After taking care of the Project Name, Experiment Name and Description Select a Run Control.

Three Run Controls are found above the Function Table. The lines in the Function Table can be run to capture a sequence of regions.
The Run button runs the complete Function Table from line 1 to the bottom of the table. The second button labeled One only runs the current active (highlighted) line. The bottom button labeled End runs from the current active line to the bottom of the Function Table. Once a capture is started additional buttons appear to control termination.
Pause, Stop, Abort and Append buttons appear to the right of the three run buttons.

**Pause – MRS tables.** Pause will temporarily stop the capture so a change can be made to the number of scans or capture time. In order to continue, click again on Pause.

**Pause – Depth Profiles.** Pause will temporarily stop the capture of a scan. During the pause the etch time or number of cycles may be changed. In order to continue, click again on Pause. If Pause is used during the etch cycle the current etch cycle will finish and then the Pause will be executed.

**Pause – Position Tables.** Pause will effect the MRS table of the current position.

**Pause – Ion Etch.** The stand alone Etch function will pause during the etch. The etch time can be changed.

**Stop – MRS Table.** “Stop” is used to stop a scan at the nearest endpoint. If the capture is unscanned then the capture will stop immediately.

**Stop – Depth Profiles.** “Stop” acts as an abort during a the Depth Profile.

**Stop – Position Tables.** “Stop” will stop the Position Table MRS at the end of the running spectrum. The Position table will be aborted.

Abort stops all operations immediately. The data taken up to the time of the Abort is saved.

Append: Normal operation is Overwrite. If a new experiment name is not entered, then the re-run of the current experiment overwrites the existing data. If you want to collect additional data under the current experiment name then you may use the Append mode. This can be used to add a new region to the experiment or to collect additional data for one or more regions. The Appended data may easily be added to the original data by using the Add Spectra function in the Tools menu. The Append mode reverts back to the overwrite mode after the Appended data has been collected.
MRS Tables - Run display

The data being acquired will be visible in the Spectrum Viewer. During data acquisition binding energies may be measured by placing the cursor on the peaks, their binding energies can be seen below in the Display Bar.

The Spectrum Viewer is used to display the current active spectrum and it will always be displayed in this window during data acquisition. Below the Spectrum Viewer/Document Control area is a display bar that shows the status of the capture process. During a capture the Idle indicator will switch to Running. The information inside of the parenthesis will show the Recipe that is being run. Additional parameters of the capture will also be displayed in this window. The next window in the Status Bar displays the cursor parameters. The third window displays the Scofield Table showing probable peak assignments as a function of cursor position.
Next section is Data Analysis

The data analysis provide for Compositional Analysis, Peak Fitting, Depth Profile analysis and other data manipulation.

To open the Data Analysis from the Capture program Click on View > Data Reduction.
ANALYSIS
DATA ANALYSIS
HIGHLIGHTS

1. Data Format 3
2. Save and Recall of Analyzed Data 5
3. Composition Table Generation 6
4. Import from SSI DOS data system (Vectra) 7

TOPICAL DESCRIPTION OF SOFTWARE

1. Analyze Composition - Introduction
   a. Auto find
   b. Area Dialog Box
   c. Area Spreadsheet
   d. Scofield Editor
2. Data Presentation
   a. Annotation and Editing labels
   b. Customize Graphics
   c. Changing scales
   d. Removing Grids
   e. Headers and Footers
3. Depth Profiles
4. Export
   a. Spectra to Vamas and Excel
   b. Spreadsheet to Excel
5. File menu
   a. Open Source
   b. Save
   c. Save As
   d. Compact Database
   e. Export
   f. Backup database
6. Manipulating Spectra
   a. Change line type and color
   b. Charging Spectra - Shift
   c. Tools for manipulating spectra
      i) Add
      ii) Differentiate
      iii) Integrate
      iv) Smooth
      v) Subtract one spectra from another
      vi) Subtract satellites
   d. Zoom and Pan

7. Peak Fitting

8. Print and Paste operations

Software conventions
1. When text boxes are White they will accept data entry.
2. When text boxes are Blue they are read only.
3. Buttons or labels that are Red indicate something is turned off.
4. Buttons that are Green indicate something is turned on.
5. Buttons that are Yellow indicate something is turned on but temporarily not in a useable state.

Manual conventions
1. Buttons and other controls that respond to the mouse are enclosed in parentheses. For example the OK button in a dialog box will be typed as (OK).
2. Keys on the keyboard are enclosed in square brackets. [ENTER] stands for the enter key.
3. Text that is required for input or displayed in a text box will be shown as <This text displayed without the delimiting symbols>. 
Data Format

The Project / Experiment Tree displays all experiments contained in the current database. The tree structure is used to locate the experiment that will be loaded for Analysis. The data stored by the capture program is listed as the <Raw Data>. The raw data is never exposed to modification. The Data Analysis program works with copies made from the raw data. After the copy is modified or analyzed the results may be stored under the original Project / Experiment name but with an additional descriptor. This new descriptor is the Analysis Name. In the tree shown above the Experiment: <survey for test> has a data set named <Raw Data> and one named <DRI1>. DRI is the Name for the analysis displayed in the graph and the spreadsheet. Stored reduced data may be recalled and further analyzed. The results of additional analysis may be saved as a new data set such as DR2 or copied over its source data set, DR1, as an incremental improvement.

This data structure provides for a high level of safety for the original data set. It also provides flexibility in saving multiple attempts at data analysis. Finally, the tree structure keeps the source data connected with the analyzed data.

The (Load Data) and (Add Data) buttons are used to initiate the load operation for the experiment selected in the tree. The load function copies over the currently displayed experiment. The user MUST use the file menu’s Save or Save As operations to save the
analyzed data. The (Add Data) button allows data from a second, or additional, experiment to be added to the displayed data set. The regions for all loaded experiments will be listed in the Loaded Region List in the lower right quadrant of the display. However, the first loaded experiment will act as the primary experiment. This primary experiment’s Project name, Experiment name and Experiment description will be displayed in the blue display boxes. The saved composite dataset will be found in the tree as a reduced data set under the primary experiment.

The (Load Data) and (Add Data) buttons can be used to load a single region. Simply expand the Experiment / Project Tree to the region level and select the region of interest. Then click on the (Load Data) or (Add Data) button.

Individual Regions can be removed from the current Document. Click on the region in the Loaded Region List and then use the keyboard [Delete] Key.

You can select a Region to view by clicking its row button in the Loaded Region List. The spectrum will be displayed. The Parameter Table will display the collection conditions for the displayed region. The displayed parameters are:

1. Region name
2. Number of Scans or collection time in seconds
3. Spot index number
4. Resolution number
5. EV/Step

The (Visible) column in the Loaded Region List provides a check box that can be used to lock a row in the visible state. After one row is locked in the visible state it can be compared to another region by selecting a second region.
Save and Recall of Analyzed Data

The File menu shown above ONLY applies to the saving of Reduced Data. As stated above the Raw Data is not brought to the screen. Raw Data cannot be manipulated or resaved under a new name with Save As. Only a copy of the Raw Data is available. The Save and Save As command will store the copy along with any changes made to the copy as addendum to the original Project / Experiment.

This approach has a few properties worth noting.

1. If Raw Data is loaded and then saved you will be offered a default name. The default would be DR1 the first time you load the data. If you accept the default, you will then have two entries in the Project / Experiment tree. One will be the original Raw Data and one DR1.

2. If you have loaded Raw Data, performed some Analysis operations and then select Save you will again be offered a default of DR1. This will allow you to save the modified copy as DR1.

3. If DR1 is then reloaded and further analysis is performed then you have the choice of saving the changes over DR1 or saving the changes with a new name. To overwrite DR1 select the Save command in the file menu. To create a separate new analysis select the Save As command.
Composition Table Generation

<table>
<thead>
<tr>
<th>Inc</th>
<th>XPS Line</th>
<th>Adj'ed Area</th>
<th>Norm Area</th>
<th>Sens'y</th>
<th>Atom %</th>
<th>Scans</th>
<th>Exp</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>N</td>
<td>22.770 635</td>
<td></td>
<td>1</td>
<td>.70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>N</td>
<td>88.397 563</td>
<td></td>
<td>1</td>
<td>.70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Si 2p</td>
<td>101.281 2240</td>
<td>225.93</td>
<td>.90</td>
<td>11.671</td>
<td>1</td>
<td>.70</td>
</tr>
<tr>
<td>5</td>
<td>N</td>
<td>152.359 2399</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>C 1s</td>
<td>282.347 10899</td>
<td>990.63</td>
<td>1.00</td>
<td>51.176</td>
<td>1</td>
<td>.70</td>
</tr>
<tr>
<td>7</td>
<td>N</td>
<td>345.937 1959</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>O 1s</td>
<td>530.157 19730</td>
<td>719.16</td>
<td>2.50</td>
<td>37.152</td>
<td>1</td>
<td>.70</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following improvements have been made to the table displays.

1. There is no Normalized Area, Sensitivity or Atom% field entries unless the peak has received an XPS Line assignment.
2. The Y symbol is automatically entered as a default value when the peak receives its XPS line assignment.
3. The ESCA 2000 V1.00 version was not picking up the sensitivity exponent from the calibration program. This is fixed.
4. The XPS Line assignments are reliably saved and recalled for all tables.
Import of DOS ESCA Data (Vectra) for Analysis

The "Import DOS ESCA Data" is a stand-alone program. This program will translate the data stored in the Vectra format (The "Vectra" ESCA program was a DOS based program developed by Surface Science Instruments that operated on early 386 and 486 PC's) to the ESCA 2000 database format use by the ESCA 2000 Analysis program.

The translated data can be stored in any existing database that is currently in use with the ESCA 2000 Analysis program. The import program will also create a new database if desired.

The import program does not attempt to create the MRS tables that were used to capture the data. This program does recreate all analyzed data as well as the raw data contained in the Vectra files.

The Vectra file navigator will allow you to use all windows file navigation tools to find Vectra files anywhere on your hard drive, removable disc or Local Area Network. Once a Vectra file is found the import program will explode the Vecra file structure and display all internal components of the Vectra file. The MRS and DPR file will be identified.
The (Browse) button is used to find the database you want to use to store your translated files. The (New) button is to create a new database to store the translated files.

The (Select All Files) button is used to mark all Vectra files in the Vectra File List for import. (Import) will enable as soon as at least one file is marked for import. The (Import) button starts the translation and import process.

If the [Ctl] key is held down as files are selected with the mouse multiple files can be marked for import. The (Clear All Files) will remove the “marked for import” condition from all files in the list.
The above figure shows six files marked for import.

After the import is complete the box with checks show which files have been imported.
ANALYZE COMPOSITION – Introduction

There are five steps to construct a compositional analysis from a survey spectrum. The compositional analysis is very common and typically part of the detailed analysis of a sample. The general steps are:

1. Find and measure the areas of the peaks in the spectrum
2. Identify the XPS emission line that produced the peak.
3. Compute the normalized area to account for the sensitivity factor associated with each emission line.
4. Choose the emission line used to represent each element in the composition table.
5. Compute Atomic percent

Before starting an analysis load a database. Use the (Open Scan Source) item in the file menu to select the database by browsing computer or network.

After the database is selected the Project / Experiment tree will be displayed.
Expand the tree to find the desired experiment and then expand to locate the Raw Data item. Click the (Load Data) button to load the regions that make up the Experiment List.

The Loaded Experiment review window will show the Project Name, Experiment Name, the Experiment Description and the Analysis Name. In the example above the Analysis Name shows <Raw Data> to indicate that no analysis has been performed and save yet. The small window summarizes the data collection parameters. Each region that is currently loaded for analysis is shown in the region list.

The spectrum for each region is made visible in the graphics viewer by clicking on the button at the left end of the row. The yellow button indicates that this region is currently the active region. All analysis operations will be performed on the active region.

Regions can be made visible but not active by clicking the Visible checkbox in the column to the right of Scan Column.
The blue color is used for read only displays. No entries are made in the Project / Experiment display windows.

The Spectrum display window has a Tool Bar that provides the main controls necessary to carry out the data analysis.
[Auto Find] locates all major peaks above a predetermined noise level. The base line for each peak is drawn and the area measured. The Area Table provides a list of the peaks that were found along with the peak location and Area. Each peak in the spectrum is labeled using the peak center binding energy.

This program does not attempt to identify the peaks. We have not found an algorithm that provides reliable identification. We have also noticed a troubling number of incorrectly labeled spectra in public and private reports. We feel that until an improved identification algorithm is developed it best to leave identification to the user.
COMPOSITION – Area Edit Dialog Box

We have provided a very fast and efficient identification procedure. The Area Edit Tool is launched when the [Auto Find] button is clicked. The [Area] button will also open the Area Edit Tool to aid in editing and identification of peak measurements. Manual area measurements can be made using the Area Edit Tool.

Dialog Box

There are two activities that need to be mastered to identify peaks quickly. First is the editing and identification dialog shown above and second is spectrum manipulation. We will first cover the dialog box shown above.

After the (Auto Find) function has been performed the spectrum will be displayed and the peak at the highest B.E. will be selected. The selection is notified by changing the background line to black instead of yellow. The dialog will be displayed with the header
COMPOSITION – Area Edit Dialog Box – Continued

(Blue band at the top) showing the BE for this peak. The correct assignment will most likely be found in the list of possible XPS lines. Click an XPS Line in the list to make a trial assignment. A set of markers will be displayed along the BE axis to show the location of all other emission lines for this choice. Evaluate how well the spectrum matches the emission lines for the selected element. You can click on a second choice. This choice will completely replace the previous one. When you determine the correct assignment you are ready to go on to the next emission line. Activate the next line by clicking the next peak of interest.

NOTE: You do not need to start with the default peak as described above. It is often best to start with the peak you want to use for the binding energy reference. See details on spectrum shifting below.

HINT: If you have trouble activating a peak try clicking inside the peak about 1/3 of the way up from the background line. Another approach is to click the B.E. label above the peak. The cursor is very busy trying to decide what you are going to do. If the cursor gets near either end point of the background line or near the stem of the label the cursor may become a hand. This indicates the program has changed into the edit mode. This mode is described below. You must avoid the edit mode when trying to send an unambiguous message that you want to select the peak.

In the simple cases you will be selecting a peak and then selecting the obvious element from the list. In cases where the assignment is not clear you will try various entries in the list to find the correct assignment. When many XPS lines are present for one element it is necessary to decide on the Primary Peak that will represent the element in the Composition Table. You may chose the primary peak by putting a “Y” in the “INC” column for the XPS line you wish to use and a “N” for all secondary entries.

The Area Edit Dialog provides a number of additional features to handle situations beyond these straightforward operations.

1. **Baseline selection.** The default baseline for a survey spectrum is the linear line. The baselines can be changed to Shirley by selecting the peak and then selecting the Shirley model. The “None” background model is useful for calculating the noise contained in the background over a specified range of binding energy. See the section: Calculating Detection Limits.

2. **Chemical Shift, Shift Offset and Global Shift.** The primary problem addressed by these three controls is charging. Insulating samples do not have an absolute reference for the Binding Energy scale. For conductors this reference is the Fermi edge. For insulators it is necessary to create a reference in order to judge the goodness of an element assignment.
COMPOSITION - Area Edit Dialog Box - Continued

It is best to choose an XPS line that is unlikely to have any chemical shift. If this XPS line is in the selection list choose it. Click the (>) button. This sets the chemical shift to zero by creating a shift offset of the spectrum. Now all binding energies are "referenced" to the selected XPS line. The shift offset is also entered into the global (Shift) box in the Spreadsheet Toolbar.

If the XPS line is not presented in the selection list, then you need to provide a rough estimate of the shift offset that would bring this line into the range of the selection search. This estimate must be entered into the global (Shift) box and press [Enter] on the keyboard. (The Shift Offset in the dialog will not accept a complete number.) The XPS line should now appear in the list. Select the line. Now click the (>) button to refine the adjustment of the Binding Energy Reference.

The global (Shift) applies to all entries in the table.

3. **Editing Background endpoints.** The Auto Find will have problems with endpoint selection in parts of the spectrum where there is extensive shake up structure, interference between peaks and on some transition metals. The endpoints may be edited using the Area editing tools. The procedure is:
   a. Click inside peak to activate the background line. It will turn black.
   b. Move the cursor to the end point. The cursor will turn into a hand with the index finger as a pointer. Right mouse click and drag the endpoint to a new location. Repeat this procedure for the other endpoint if necessary.
   c. Click on the (Measure) button to re-measure the area under the peak using the new endpoints.
   d. Select the XPS line.

Note: The endpoints can be nudged one data point at a time. Activate the baseline. Place the cursor near the endpoint of interest. Hold the shift key down and tap right or left arrow key.

4. **Measure Area of Peak.** To measure the area of a peak from scratch move the cursor to one side of the peak where you want to start the background line. Put the cursor at the junction of the binding energy marker and the spectrum. Left click and drag to the other side of the peak. The background line will be drawn as you drag to the second endpoint. The type of background line will depend on the type selected at the top of the dialog box in the background group.

There are two competing actions when the left mouse button is clicked. One is the Zoom feature, which will be discussed below, and the other is the drawing of the background line. In order to get the background to draw it is
important to place the pointer on a spectrum data point. The distance you can be from the data point is adjusted in the Preference dialog. This is the pencil. After the background is drawn then click the (Measure) button. Select the XPS line in the list.

5. **Mid-Point pinning.** It is sometimes useful to include two parts of a peak with one background line. But, in some cases the Sherley background does not interest with the spectrum at a minimum point near the center. See example below.

This problem can be solved using the mid-point pinning feature.
COMPOSITION – Area Edit Dialog Box – Continued

The first step is to move the small vertical marker to the binding energy that needs to be pinned as shown above. (The yellow line would be in the unpinned position.) Put the cursor on the marker and left clicking, then drag the marker to the desired location. Click the check box at the bottom of the dialog. Click the (Measure) button. At this point the display should look as shown above. To remove the black line, click any where away from the spectrum.

6. **Checking a spectral region for the presents of other elements.** Some times it is convent to input an element name or symbol and display its XPS line markers. This can be done using the find tool at the bottom of the dialog. Enter an element symbol or full name and click (Find).

7. **(Apply) button labels all secondary peaks.** As described above it is generally useful to identify the most prominent peaks first. In this process it is often necessary to decide which XPS line will be the primary peak. The primary peak will represent the element in the composition table. If many peaks are present it is helpful to label the secondary peaks. Then as the identification process continues it is easy to see which peaks remain unlabeled.

The (Apply) button will label all secondary peaks without computing their normalized areas. After selecting the XPS line assignment for the primary peak click on the (Apply) button. The XPS line assignment will enter the Primary line assignment into the Area Spreadsheet. The (Apply) button will place a label at the binding energy where each additional XPS lines should be found. The Apply process does not make entries into the spreadsheet.
COMPOSITION – Area Edit Dialog Box - Continued

After using (Apply) button to label spectrum
As the peaks are identified using the Area Edit dialog tool four task are automatically accomplished.

1. XPS Line assignment is entered into the table and the spectrum peak is labeled.
2. The photoelectron emission crosssection is looked up in the Scofield Table and the sensitivity factor is calculated. The sensitivity factor takes into account the variation in escape depth as a function of kinetic energy. The adjustable parameter is the Sensitivity Factor Exponent. This exponent is displayed as Exp in the table.
3. The Area is normalized to account for variations in Ev/Step, Detector Width, Scanned versus Unscanned and Dwell Time/Step. This normalization allows a very wide variety of operating conditions to be inter-compared in one Composition Table.

Note: The change in transmission function versus pass energy (RES #) and the change in x-ray flux versus spot size are not accounted for in the normalization process.

4. The Include (Inc) cell for the assignment is marked Yes (Y) so this assignment will be included in the Summary Composition Table found using the Composition tab.
COMPOSITION – Area Spreadsheet - Continued

It is often useful to assign more than one XPS line for the same element and review how
the various lines vary in their estimate of the Atom percent. Ideally all lines would
provide the same estimate. If you had a pure sample and assigned three XPS lines they
should all be displayed as 33.3%. In practice this is not observed. If a thin film is
covering the sample then the higher binding energy lines will be depressed because the
lower kinetic energy electrons are more like to be scattered by the film than the high
kinetic energy electron.

The composition sheet of the NOTEBOOK summarizes the AREA and PEAK sheets for
ALL Regions in the REGION LIST. This is powerful and dangerous. See following.

The parameters summarized are:
- XPS Line
- Adj’ed BE
- Norm Area
- Sensitivity
- Atom %

In the usual case the survey is used to generate the data used in the composition table and
the Composition spreadsheet is simply a summary that is useful for printing or copy and
pasting to other programs.

In special cases high sensitivity scans may be used to detect trace elements or peak fitting
may be used to resolve overlapping emission lines. If the data from either of these cases
is combined into one composition table with data from a survey scan then the data must
be taken with the same Resolution setting and Spot Size setting. The ev/step, number of
scans and scan width can be mixed. Scanned and unscanned can also be mixed.

When a number of different regions are combined then you must keep track of the source
of the data sent to the summary table. Any number of regions in the region list can send
data to the summary composition table. Both area measurements and peak fits can be
included. The include parameter controls what is included. The “Y” symbol includes
the data for an XPS line and an “N” symbol will cause the assignment to be skipped.
Any XPS emission line in either the area sheet or peak sheet that has a “Y” in the include
column will be included. The Area sheet and the Peak sheet act independently. The
Composition Sheet is the summary for all regions and the summary displayed does not
depend on which region is active.
COMPOSITION – Area Spreadsheet - Continued

Consider the example that a survey has been taken on a steel sample and a composition table generated. However, on review you are concerned there may be a small silicon signal at about 150 ev. A high sensitivity scan in res 4 with 0.4 ev/step is taken from 90 ev to 160 ev binding energy. This experiment is added to the region list. The area of a small peak at 150ev is measured using the area tool in the edit mode. When the XPS line assignment is made for Si 2s the include column will have a “Y” entered. If you go to the Composition Sheet you will find this assignment along with the assignments made from the survey.

You could also peak fit the Si 2p region to resolve the silicon and iron interference. You would enter Si 2p for the component at 100 ev and Fe 3s for the component at 95 ev. Notice that the include parameter is not automatically changed to “Y” in the peak fit mode. After entering “Y” for each component you will go to the survey and set the include parameter for the Fe 2p peak to “N”. Now review the Composition summary.
COMPOSITION - Scofield Editor

The Scofield table is used to store the XPS cross-sections, line positions and line position ranges. These can be edited to add additional lines, modify cross-sections, and adjust line position ranges. To open the editor, use the (Settings) button of the Analysis Toolbar. Select the [Edit Scofield Table] menu item.

The controls at the bottom of the spreadsheet provide tips on their use. When the table is closed, it will save the changes and resort new entries in alphabetical order.

We provide no provision for multiple tables at this time.
Data Presentation

Data presentation is divided into two parts, composing the graphic and output. The tools covered in this section for composing the graphic are:

a. Annotation and Editing Labels
b. Customize Graphics
c. Changing scales
d. Removing Grids
e. Headers and Footers
f. Special Graphic formats

The tools for output are covered under the Print and Paste section of this manual.

Data Presentation – Annotation and Editing Labels

The Annotation button on the toolbar presents a stem and label at the center of the graphics window as shown above. This initial label has some interesting properties. You may use the mouse to drag the lower end of the stem to any location. The label will report the exact binding energy of the endpoint of the stem. The label may likewise be moved to any location. If the label is activated using the mouse it may be fully edited.

To move the stem or label, approach the bottom of the object until the cursor changes into a hand. Left mouse click and drag the stem or label. To edit the label approach
Data Presentation – Annotation – cont

the bottom of the label with the mouse until the cursor becomes a hand. Right mouse click to open the Change Annotation Properties dialog. You may change the label making an entry into the caption box. The orientation and alignment may be changed. These operations are displayed in the following screen captures.

Move stem to new location
Move Label

Edit the Caption, Angle and Font then click done.

Any annotation, including those applied using by the Area or Peak Dialogs, may be edited using the Change Annotation Properties dialog.

A selected Annotation may be deleted using the delete button.
Data Presentation - Customize Graphics

The graphics window can be converted into a number of formats and made available to other programs. It is useful to customize the graphic image to meet your needs before you export it in some format because after the translation into an export format you lose flexibility. The tools available in the toolbar vary in complexity. The tools are:

1. Panel fill color
2. Min / max scale
3. Remove grids
4. Headers / footers
5. Titles

1. Control spectrum color
2. Axis increment
3. Background color

To remove the gray panel color Select the (Chart Editor) button on front page of the Graphic Editor. Select the (Panel) tab and then the (Panel Color) button. To set the background to white click the white color patch. Use the OK button to back out of the Color dialog. Close to back out of the Editing dialog and Done to close the 3D View properties dialog.

Graph with white background
Change spectrum color.

Change Back Ground Line color.
Data Presentation - Changing scales

Use the Preferences to change form fractional numbers on x axis and the increment control to reduce the number ticks on both axes.
Data Presentation – Remove grids

The remove grid operation involves a number of steps and demonstrates the extensive control over the graphic window. The steps to remove the grid are:

1. Open Graphic Editor (3D View Properties)
2. Open Chart Editor
3. Select Axis Tab
4. Choose the [Left] Axis as the active axis
5. Open the Grid Border Color Editor
6. Remove the check from the [Visible Box]
7. Select [OK] on Border Color Editor
8. Choose the [Bottom] Axis as the active axis
9. Open the Grid Border Color Editor
10. Remove the check from the [Visible Box]
11. Select [OK] on the Border Color Editor
12. Select [Close] on the Editing dialog
13. Select Done on the 3Dview Properties
The Graphic Editor was used to create a header, or Title, and a footer that can be used to provide figure descriptions. The Title Tab on the Chart Editor provides control of the founts, title alignment, borders for the titles and background colors or patterns.

Data Presentation – Special Graphic Formats

The [General] Tab provides for Export of the graphic to 5 different formats and to Clipboard or file. The exported graphic can be imported to many other applications.
Data Presentation – Special Graphic Formats – cont.

Fig 3. Survey spectrum of contaminated silicon wafer
The clipboard on the toolbar was used to copy and past this spectrum into Word.
DEPTH PROFILES

When a Depth Profile is loaded a preview is presented that shows all the regions of the depth profile on the same binding energy scale. The Region List only reports that a Depth profile is loaded but does not list the region in the preview.

Depth Profile Preview

To open the Depth Profile you need to place the cursor in the white box under the Scan column of the Region list and click the left mouse button. This box will show the name of the Depth Profile. After clicking the mouse button hit the space bar on the keyboard. Then select a region of interest in the Region list.

You can move through the cycles for this region by using the shift key and the up or down arrow keys. The current cycle will be displayed in the lower status bar. For the shift-arrow key control to be active the Graphic Window or the Region List must be active. To activate the Graphic Window or the Region list move the cursor to either window then click.
Depth profiles — cont

To switch to the Depth Profile chart you click the DP icon in the toolbar. The vertical black line indicates the Au 4f graph, cycle 3 at 30 second into the etch. The DP icon provides a toggle that allows you to jump back and forth between the DP chart and a spectral region. You may move the Active Point indicator to any point on any chart line and then click the DP icon to jump to the spectrum for that point.

Hint: The cursor tries to follow your motion when the cursor is in the Graphics Window. When you want to toggle to a new region it is helpful to move the cursor vertical up to the toolbar, keeping the Active Point in place. Then move along the tools to the DP icon to toggle to the Region view.

The Depth Profile shown above has large negative areas for three of the elements. This is a result of poorly selected end points for the area measurements. The default DP sets the end points at the edges of the window to provide an initial presentation. It is important to edit these end points to improve the accuracy of the area measurements.

Editing area measurements is very easy. The steps are:

1. Select a representative cycle for one of the regions
2. Click the (Area) icon to activate the Area measurement editor.
3. Activate the existing area by clicking the base line near the center between the end points. The baseline will turn black
4. Move the cursor toward one end of the spectrum until the cursor turns into a hand. Left mouse click and drag the endpoint marker to select a new endpoint. Repeat the endpoint edit operation for the other endpoint.
5. Click the (Measure) button in the Area Edit Dialog box.
6. Select the XPS emission line form the list.
Depth profiles — cont

When you click the (Measure) button the new endpoints are applied to all cycles for the selected region. You can toggle back to see the effect the edit has made on the DP.

It is often helpful to view all region stacked up. The Depth Profile Viewer is useful for reviewing the endpoint selections.

When the Area Edit Tool is displayed and the background line is active for the spectrum in the Graphic Display window then the endpoint markers of the Depth Profile Viewer will track the endpoint marker in the Graphic Viewer. As you drag the endpoint to adjust the background you can also review the endpoints for all cycles for the active region.

To turn on the Depth Profile Viewer be sure the cursor is active in the Graphics Viewer window, then right mouse click. A menu will be displayed that allows you to toggle between Depth Profile and Region View and also to turn on the Depth Profile Viewer. The Toggle control is identical to the (Dp) icon in the tool bar.
Depth profiles – cont

Open the Depth Profile Viewer from the menu displayed after a right mouse click with the cursor on the Graphics Viewer window.

The (View) button allows control of which spectra are displayed. The spectrum separation box allows you to separate the spectra in the y direction. The (Separate) turns the separation effect on and off. The (Cycle in Front) button selects rather the first or last cycle is shown in front. The 3D effect are available through the Graphic Edit icon.
Depth profiles – Future

A new Depth Profile analysis section is under design. This program structure has reached some technical limits. We have chosen to make fundamental changes instead of patching over the current limitations. Providing a flexible approach to the selection of regions to be included in a Depth Profile that displays atomic concentration is the tip of the iceberg. Labeling the x-axis in terms of depth, given the input of an etch rate, is a second short fall.
Export - Spectra to Vamas and Excel

1. Select an Experiment. If only some regions are to be exported mark them visible.
2. Select Export in the File menu.

3. Choose All regions or Only Visible regions. Select type of export.
Export To VAMAS and EXCEL – Cont.

The VAMAS export is an ASCII file readable by any text editor. The arrangement of information follows the international standard for Surface Science Data. All region of the MRS can be included in one VAMAS file. The VAMAS file can hold a complete depth profile. This is a very flexible and well-defined export file.

To use the Excel export, Excel must be available on the computer running the ESCA application. It does not need to be running. The export will open an Excel notebook, fill header cells with instrument parameters and provide a column of numbers representing the spectrum data. A crude graph is also created for quick review. There will be one page per spectrum. All spectra for a MRS table or just the regions marked visible can be included. A depth profile can be exported.

In the Analysis Application, if the EXCEL export is chosen, the data that describes the backgrounds for surveys and peak fits will be exported. For peak fits the peak envelopes will also be exported. This provides all information necessary to general purpose graphing programs.

Fakedata.txt is an internal text file used for demonstration purposes. Any spectra can be converted to a fakedata.txt file and then used by the Demo program to simulate the collection of data. This can be convenient for training and remote investigation of the program operation.

The Export File Dialog is used with the VAMAS export. This is a standard Windows dialog. File storage for the Excel is handled out of the Excel program.
Export Spreadsheet to Excel

Enter the file name for the Excel spreadsheet you want to create and click Save.

Open Excel and open the file. The full spreadsheet for all three tables will be presented. Field for all parameters of the collected and reduced data are presented. The formulas that are used to compute field of derived data are imbedded so the spreadsheet is functional.
File menu - Open Source

The (Open Scan Source) menu brings up a very general dialog that let you find a database anywhere on the host computer or network. Select an ESCA 2000 database and click the (Open) button.

File menu – Save and Save As

The (Save) and (Save As) operations store the Spectra, Composition Tables, Peak Fits and Annotations into the Database as documents. The named documents have links back to the raw data. A list of raw spectra and Analysis documents are displayed in the tree view in the upper left corner of the program display.

An Analysis document can be re-loaded and edited. The edited document can be saved back to the database or saved as a new document using (Save As).
File menu – Back up

If backup is used a copy of the database is stored in a location of you choice. The default name is “original name.mdb.bak”. To use the backup database remove the .bak suffix. Then open the database with the Open Scan Source menu item.

When attempting to remove the .bak suffix be sure the original database is not in the same folder. Windows will not let you have two files with the same name in one folder. Rename the original file by adding a suffix .bad or some other name before you restore the backup file.

File menu – Compact Database

As the database is used space is reserved to accommodate many possible inputs. Most of this space is never used. The compact operation is a house cleaning operation performed by the Access database engine. This does not change the form of the data stored in the database. The database does not need to be unpacked to use. The only down side of compacting the database is it must not be in use by any Application.

The Analysis and Capture Applications attempt to compact the database when it is selected but before it is loaded. If the selected database is already open by any other program, including Import form Dos, then it just goes ahead and loads. If the database is never closed and reopened then it will not be compacted. Either of these cases can lead to bloating of the database.

It is important to compact the database on a routine bases or it will get very large. Depth profiles can cause the database to get very large fast. If the database exceeds about 2 G bytes then Access fails. Some users have suffered crashed program operation.

Chose one of two procedures. Have all users who have access to the same copy of one database close down all their ESCA 2000 programs. While all programs are closed start up one copy of either the Analysis or Capture program and load the database to be compacted.

If only one computer has access to a database then close all but one application. For example if the computer is running the ESCA the close down the Analysis Application and the Import Application. Then select the (Compact database) item in the File menu. The same idea can be used with a stand alone data reduction computer.

File menu - Export

See previous section on Export to Vamas and Excel.
Manipulating Spectra - Change line type and color

To change color of the line use to plot the spectrum:

1. Select the region from the Region List. This will establish the active spectrum.
2. Open the Change Color and Line Style dialog.
3. Click the button to the left of the desired color.
4. Click Apply

The Line styles are not operational in this release.
Manipulating Spectra - Charging Spectra - Shift

There are three controls that effect the position of the spectra on the graph.

1. The Composition Table Toolbar has a (Shift) window that provides a Global Shift for all regions listed in the Region list.

2. The Area Edit and Peak Edit dialog has a set of controls that show the chemical shift for a selected peak compared to the typical value listed in the Scofield table. The displayed chemical shift can be set to zero by shifting the spectrum. This allows the selected peak to become the reference peak for the entire spectrum. By clicking the (>) button to zero out the chemical shift a shift offset is applied to the spectrum and entered in to the Global Shift for the composition table. This Peak referencing then applies to all regions in the Region List. All entries in the adjusted Binding Energies column, of the composition table, are adjusted by this shift offset.

3. The Region List has a column named Xoffset. This column shifts the display of the spectrum but has no effect on the Binding Energy values recorded in the table. This control is useful for offsetting overlays and restoring the displayed spectrum to it captured position with out disturbing the composition table.
Manipulating Spectra - Charging Spectra – Shift - cont

After clicking the Reference button the Global Shift is 2.25, the adjusted B.E. is 284.597 and the Shift Offset is 2.25. The Xoffset for the region is not affected.

Xoffset in Region list set to (0). Spectrum offset due to Shift Offset.

Xoffset in Region list set to (-2.25). Spectrum moved back to origin. Peak label matches scale. Adj BE in spreadsheet is still referenced to C 1s.
Manipulating Spectra - Tools Menu for manipulating spectra

The [Tools] button on the toolbar opens a tool kit for manipulation of spectra. The icons from left to right provide the following operations:

1. Add two spectra
2. Subtract one spectra from another
3. Smooth
4. Integrate
5. Differentiate
6. Subtract satellites

The [DoIt] button puts the tool bar into an immediate action mode. With this button selected the conditions set for each of the tool icons will be used without review when the icon is clicked. This mode is useful when the tool will be applied to many spectra using exactly the same setup conditions.

The [w/Setup] button puts the tool bar into a mode that shows the setup dialog before the tool is applied to a spectrum. The setup dialogs have a lower section that is very similar for all tools. This section, called the Results Location, defines how the display of the Primary or Source spectrum and the resultant spectrum will be handled. It also defines the region naming protocol.

If the [Create new Region Name] button is selected then the [New Region Name] box will be open and you can enter a name of your choice.

If [Source Region Name + {code}] button is selected then the [New Region Name box will be disabled and the program will append a code to the existing Region Name. Clicking the [Remove Primary Region from display] check box will cause the source spectrum to be replaced by the modified spectrum.
Manipulating Spectra - Tools Menu for manipulating spectra – cont.

The [Do It] button at the bottom causes operation to be performed on the target spectrum.

The dialog is slightly different for the [Add] and [Subtract] tools.

The Primary Region is established by checking the [Visible] box for the region you want to subtract another spectrum from. The Secondary Region is established by activating the Region. Click on the region name in the Scan column of the Region List to activate. This spectrum will be subtracted from the Primary Region.

The option to Remove either or both the Primary or Secondary Regions is added to the Result Location operations.

The top part of each Tool Parameters dialog describes the operation to be performed and the parameters that define it. Examples follow.
Manipulating Spectra – Add two spectra

Step 1. Check visible for Primary region and select Secondary region.
Step 2. Click [Add] Icon
Step 3. Shift spectra (Optional). Move arrows to mark alignment points. Click Shift.
Step 4. Configure Result Location dialog.
Step 5. Click [Do It]

The Primary Spectrum is showing because the Visible box is checked. Both the Primary and Secondary spectra are still listed in the Region list.
Manipulating Spectra – Subtract two spectra

The steps are the same to set up the Subtract and Add spectra tools. The Subtract tool has the additional ability to scale the Secondary spectra to the Primary spectra. The above figure shows the display after moving the pointers to the alignment points on the two spectra. The long vertical line is used to establish a third point, along the background, where the two spectra will be matched.

To match the two spectra first [Shift] the spectra to align the points marked by the green and red arrows. This step is optional.

Next the scaling operation will match the spectra at the points marked by the arrows and at the point marked by the vertical line. This involves both a scale and Y offset operation. If the vertical line is moved to the same location as the arrows then the Secondary peak will simply be scaled up. The background will not offset to match.
Manipulating Spectra – Subtract two spectra -cont

After the [Scale] button is clicked the difference between is noticeable at the right side of the spectra.

The Primary Region and Secondary Region are removed both removed from the region list and the display. The Difference spectrum is displayed and is listed as Regn1(SubSp). The difference spectrum can now be operated on by any of the tools including peak fitting and area measurement. In the next section we will smooth the peak.
Manipulating Spectra – Smooth, Integrate and Differentiate

In this example we used an 8 point, Normal smooth. The result was saved by appending the code `{smooth}` so the Region name is now `Regn1 {SubSp} {Smooth}`. Source was left in the Region List. The Source was made visible after the smooth operation so we could compare it with the smoothed spectrum.

This approach of appending the code to the current Region name provides the history of operations to be encoded onto the region name.

The integrate and differentiate modes work the same way. Neither operation has additional parameters.
Manipulating Spectra – Satellite Subtract

The parameter section of the Satellite Subtract allows for use of the satellite parameters stored with the spectra or if none are stored the full strength of the satellite peaks will be used. If adjustment of the Satellite peak strength is desired then the filter can be turned on a new values can be established. These values are stored until new numbers are entered in the dialog box.

The first example is to use the existing parameters. In this case the parameters described full strength satellite peaks.
The over correction has been minimized and the Cl 2s peak remains.
Manipulating Spectra - Zoom and Pan

The (Zoom Toggle) icon provides a toggle between displaying the full spectrum and the expanded spectrum. To zoom in on a region of the spectrum follow the directions that follow.

**ZOOM**

A zoom box can be defined using the mouse.
Click and hold the left mouse button at the upper left corner of the area to be expanded.
Drag the mouse to the lower right direction until the area of interest is enclosed.
Releasing the left mouse button now displays the expanded area.
The Zoom action can be repeated.

To reverse the Zoom left click and hold. Draw any size box from lower right to upper left. When the mouse button is released the display will return to the initial state.

The Zoom window can be moved along the spectrum in the X and Y directions.
Depress the right mouse button and drag the window to the new location.
This provides a convenient way to scan along a spectrum looking for small features.
After zoom

The (Zoom enable) icon can be used to restore the zoom function if it becomes disabled.

If you are using a mouse with a "page up/page down" wheel between the right and left mouse buttons this function will step the spectrum up and down within the graph. This is useful to set the minimum point of the spectrum on the X-axis. This produces the equivalent of a background-subtracted spectrum.
PEAK FITTING

Click on Peak.
In the Measure Peak dialog box choose the appropriate background type, establish the background end points and then click on Measure.
The **MEASURE** button will transfer that portion of the spectrum defined by the baseline endpoints to the Peak Fit Window.

**Peak Fit – Edit Peaks**

Clicking in the spectrum will add a peak represented by a sizing box. Right clicking the mouse in a box pops up a context menu. Impose constraints for fitting using the peak list grid. Asymmetry and Gaussian percents are editable as test.
Click near the center of each component peak. This will draw boxes that show the peak amplitude, center and a FWHM estimate. A menu of the peak parameters appears below the spectrum window. Right click the mouse for a menu of peak fitting controls and shortcuts.

![Menu Available after Right Clicking in the Spectrum](image)

The cursor can pick up the midpoint handles of the boxes used to define the peaks and move the amplitude, left side or right side. The location of the boxes can be also be changed by placing the cursor inside the peak then click and drag.

Peak parameters may be individually constrained and unconstrained by clicking on the "lock" icons left of the parameter value. This will also display a menu of constraint options.

![Constraint options after clicking on lock icon](image)
Click on Begin Fit.
Peak parameters may now be adjusted in order to optimize the peak fit. Click on Edit Peaks, make necessary parameter changes, and again click on Begin Fit.

Upon completion of an acceptable peak fit click on the “Save” button. This will save the spectrum and show the component peaks in the Spectrum Viewer. “Save” also saves the peak parameters and displays them in the Peaks spreadsheet of the Data Notebook.

In order to make the peak fit area values available to the Composition spreadsheet in the Data Notebook use the Element List to label the peaks and Enter “Y” for each component peak in the Inc column.

In order to make survey and/or peak areas available to the Composition spreadsheet assign the peaks in the XPS line column (use the element list box for assignment) and place “Y” into the “Inc” column of the appropriate rows of the “Areas” or Peaks” spreadsheets. Hit the “Enter” key.
With Y entered for each C (1s) peak the peak compositions are now available in the Composition Table.

The REGION LIST in the DOCUMENT CONTROL window can be used to review the peak fit results. As various REGIONS are made active the spectrum will be shown in the SPECTRUM VIEWER, the peak fit curves will be overlaid on the raw data and the peak fit data will be displayed in the PEAKS sheet of the DATA NOTEBOOK.
Move the cursor near the bottom of the peak identifier until a hand icon appears. The Change Annotation Properties window will appear.

Use these tools to place captions or other labels onto the spectra.
Print and Paste operations

The **Print** command opens **Print Designer**, which offers a set of tools to enhance data presentation.
Print and Paste operations – Print Designer

The Print Designer tool set.

Customize Table Properties

Settings For. At the beginning of a session with the Print Designer Preferences you must select the Table that is being configured. Select either the Peak Fit or the Composition Table.

Auto Generate. Check the box to include a table when the Print Designer is opened. The table selected depends on the table showing in the Analysis window when the Print
Print and Paste operations – Customize Table Properties -cont

Designer is opened. If the Peak fit table is showing then it will be copied to the Print Designer. If either the Composition tables is showing then the it will be copied.

If the box is not checked the (Include Peak fit) or (Include Comp) icons can be used to copy one of the tables to the Print Designer. Again the table to be copied must be showing in the Analysis window.

Background. The background for the Comp Table or the Peak fit Table can be chosen form the color chart or set to match the spectrum background. The spectrum background is inherited from the Graphics Editor in the Analysis Window.

The transparent mode is not operational.

Columns included. This tool allows the selection of the parameters displayed in the Table and their order of display. Enter a <0> in the (Order) column to not display a parameter. If you set a parameter position to <0> it will remove the parameter and move all remaining parameters to the left. For the parameters you want to display enter an integer that represents the column display position for that parameter. If you enter a number that exist it will insert the parameter in that position and move all the remaining parameters to the right.

Font. The font tool provides the standard Windows font controls.

Note: After changes are made using the Customize Tables Properties dialog the Print Designer must be closed and then the Print button on the Toolbar of the Analysis Window must be clicked to show the Print Designer changes.
Print and Paste operations - Design header and change layout

The Print Designer is built on a spreadsheet model. The full spreadsheet designer is available to compose the layout of the imported metafiles for the Spectrum and the Table. Cell programming is used to construct the header. Enter labels in cells and then imbed the corresponding program variables in the adjacent cell. Standard cell formatting is used to create the header cell boarders and other enhancements.

Select the (Design header and change layout) icon to open the VCI Designer.

The grids are shown by opening the sheet formatting dialog and checking the Gridlines check box. After editing the header turn the gridlines off and exit the VCI Designer. To open the Format Sheet dialog select the Format menu > Sheet > Properties.

To print long tables the sheet limits need to be extended form $44$ to $88$.  

66
Print and Paste operations - Design header and change layout — cont.

The table is a metafile object that can be placed any where on the spreadsheet.

Close the VCI Designer and move the lower boarder of the Print designer window.
Print and Paste operations – From Print Designer

Before printing bring the bottom of the window up and the right side of the window in to leave a small white space around the part of the form you want to print or copy to the clipboard. The print object that is transferred is the size of the window. This object will be centered on and scaled to the page. Strange distortions take place if the window is left too large.
Print and Paste operations – Spectrum View Window - Clipboard

The above graph was copied to the clipboard and pasted into this word document. No scaling or readjustments were necessary.
Print and Paste operations – Spectrum View Window – Print

This print setup provides Portrait and Landscape print, margin control, printer selection and Printer setup for the selected printer.
The TeeChart Export tool in the Graphics Editor provides a wide range of export formats for the spectrum. The Enhanced Metafile provides a format that can be edited in Word, Power Point and Paint. The frame was added and the line labels formats changed.
Print and Paste operations – Comp and Peak Tables

<table>
<thead>
<tr>
<th>Operator: Administrator</th>
<th>Date: 3/20/2001</th>
<th>Cycle: 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td><strong>Shift</strong></td>
<td><strong>2.25</strong></td>
</tr>
<tr>
<td><strong>Print Preview</strong></td>
<td><strong>Print Setup...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Save All</strong></td>
<td><strong>Adj'd Be</strong></td>
<td><strong>Norm Area</strong></td>
</tr>
<tr>
<td>2</td>
<td>O 1s</td>
<td>532.407</td>
</tr>
<tr>
<td>3</td>
<td>Ca 2p</td>
<td>348.187</td>
</tr>
<tr>
<td>4</td>
<td>C 1s</td>
<td>284.597</td>
</tr>
<tr>
<td>5</td>
<td>Si 2p</td>
<td>103.531</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The print preview button, in the File menu of the Spreadsheet window, provides a print out of the table. The Area, Peaks and Composition Table will be previewed depending on which one is displayed.